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1 Get started
This guide provides details about how to use the printer and to resolve problems.

• Accessibility
• HP EcoSolutions (HP and the Environment)
• Understand the printer parts
• Use the printer control panel
• Find the printer model number
• Select print media
• Load an original in the scanner
• Load media
• Install and use the battery
• Insert a memory device
• Print from mobile phones
• Maintain the printer
• Turn off the printer

Accessibility
The printer provides a number of features that make it accessible for people with
disabilities.

Visual
The HP software provided with the printer is accessible for users with visual
impairments or low vision by using the operating system's accessibility options and
features. The software also supports most assistive technology such as screen
readers, Braille readers, and voice-to-text applications. For users who are color blind,
colored buttons and tabs used in the HP software and on the printer control panel have
simple text or icon labels that convey the appropriate action.

Mobility
For users with mobility impairments, the HP software functions can be executed
through keyboard commands. The HP software also supports Microsoft® Windows®
accessibility options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The
printer doors, buttons, input tray, and paper guides can be operated by users with
limited strength and reach.

Support
For more details about the accessibility of this printer and HP's commitment to product
accessibility, visit HP's Web site at www.hp.com/accessibility.
For accessibility information for Mac OS X, visit the Apple Web site at www.apple.com/
accessibility.
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HP EcoSolutions (HP and the Environment)
Hewlett-Packard is committed to helping you optimize your environmental footprint and
empowering you to print responsibly—at home or in the office.

For more detailed information about environmental guidelines, HP follows during the
manufacturing process, see Environmental product stewardship program. For more
information about HP's environmental initiatives, visit www.hp.com/ecosolutions.

Manage power
To conserve electricity and extend the length of time you can use the printer, the
printer comes with the following features:

• Sleep mode
Power usage is reduced while in Sleep mode. To configure sleep mode settings,
touch Power Meter on the printer's control panel display, touch Settings, touch
Sleep Mode, and then touch the desired option. After the printer has been
inactive for this period of time, the printer will go into a low-power mode.

• Auto-Off
When Auto Power-Off is enabled, the printer will automatically turn off when the
printer has been inactive for the configured period of time. To configure Auto
Power-Off settings, touch Power Meter on the printer's control panel display,
touch Settings, touch Auto-Off, and then touch the desired option.

In addition, try the following:
• Turn off Bluetooth when not in use. To turn off Bluetooth, touch Bluetooth on the

printer's control panel display, and then touch Turn Off.
• To maximize battery life and capacity, be sure to charge, use, and store the

battery in places that meet the recommended temperature guidelines. For more
information about using the battery, see Install and use the battery.

Optimize printing supplies
To optimize printing supplies such as ink and paper, try the following:

• Recycle used original HP ink cartridges through HP Planet Partners. For more
information, visit www.hp.com/recycle.

• Optimize paper usage by printing on both sides of the paper. If the printer has an
HP automatic two-sided printing accessory (duplexer), see Print on both sides
(duplexing). Otherwise, you can first print just the odd pages, flip the pages over,
and then print just the even pages.

• Save ink and paper when printing web content with HP Smart Print. For more
information, visit www.hp.com/go/smartprint.

• Change the print mode to a draft setting. The draft setting uses less ink.
• Do not clean the printhead unnecessarily. Doing so wastes ink and shortens the

life of the cartridges.

Chapter 1
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Understand the printer parts
This section contains the following topics:

• Front view
• Printing supplies area
• Back and side view
• Bottom view

Front view

A5

B5

A4
LTRLGL
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1 Input tray extension

2 Input tray

3 Narrow media guide

4 Control panel

5 Control panel latch

6 Power button
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7 Cartridge access door

8 Output slot

9 Output door

10 Scanner media width guide

11 Media width guide

Printing supplies area
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1 Cartridge access door

2 Print cartridge latches

3 Print cartridge cradle compartments

Chapter 1
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Back and side view

1 2

3
4

5
6

1 PictBridge Host USB port

2 Battery connector cover

3 Universal serial bus (USB) port

4 Battery slot

5 Power input

6 Memory card slot

Bottom view
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1 Cover of replaceable ink service module

2 Card holder

Use the printer control panel
This section contains the following topics:

• Overview of buttons and lights
• Control-panel display icons
• Change printer mode and settings

Overview of buttons and lights
The following diagram and related table provide a quick reference to the printer control
panel features.

NOTE: The buttons around the color display are available only if the action is
supported.

45

6

7

1 2 3

Label Name and Description

1 Home ( ): Touch this to return to the Home screen from any other screen.

2 Color display: The color display is a touch sensitive (screen) user interface used to navigate
and select the desired printer function.

3 Help ( ): Touch the Help icon to open the Help screen.

4 Cancel: Stops a job, exits a screen, or exits settings.

5 Right arrow (right arrow ): Navigates through settings in the screens.

Chapter 1
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Label Name and Description

6 Back ( ): Touch this to return to the previous screen.

7 Left arrow (left arrow ): Navigates through settings in the screens.

Control-panel display icons

Icon Purpose

Displays a screen where you can make copies or select other options.

Displays a screen where you can make a scan or change scan settings.

Displays a screen where you can adjust photo printing options.

Displays the Setup screen for generating reports and changing settings. 

Displays a screen where you can see information about the ink cartridges,
including estimated fill levels. 

NOTE: Ink level warnings and indicators provide estimates for planning
purposes only. When you receive a low-ink warning message, consider having
a replacement cartridge available to avoid possible printing delays. You do not
need to replace cartridges until print quality becomes unacceptable.

Displays the Bluetooth options and setup.

Displays the battery and power options.

(continued)
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Change printer mode and settings
Use the control panel to change the printer mode (such as Copy or Scan) and settings
(such as the number of copies or the scan destination). Also, you can use the control
panel to print reports or get help for the printer.

TIP: You can use software programs provided with the printer to change printer
settings from a computer. For more information about these tools, see Printer
management tools.

Select the mode and change the mode settings
The home screen of the control-panel display shows the available modes for the
printer.

1. To select a mode, touch the left arrow  or the right arrow  to see the available
modes, and then touch the icon to select the desired mode. To change the
settings for a mode, after selecting a mode, touch the arrow buttons to scroll
through the available modes settings, and then touch the setting you want to
change.

NOTE: Use the  (Back) button to return to the previous menu.

2. Follow the prompts on the display to change the settings. The control-panel
display returns to the home screen when the job is finished.

Change the printer settings
To change the printer settings or print reports, use the options available in the Setup
screen:

1. Touch the right arrow , and then touch Setup.
2. Touch the arrows to scroll through the screens.
3. Touch the screen items to select screens or options.

NOTE: Use the  (Back) button to return to the previous menu.

Find the printer model number
In addition to the model name that appears on the front of the printer, this printer has a
specific model number. You can use this number when obtaining support and to help
determine which supplies or accessories are available for the printer.

The model number is printed on a label inside the printer, near the ink cartridges area.

Select print media
The printer is designed to work well with most types of office media. It is best to test a
variety of print media types before buying large quantities. Use HP media for optimum

Chapter 1
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print quality. Visit the HP Web site at www.hp.com for more information about HP
media.

HP recommends plain papers with the ColorLok logo for printing
and copying of everyday documents. All papers with the
ColorLok logo are independently tested to meet high standards
of reliability and print quality, and produce documents with crisp,
vivid color, bolder blacks and dry faster than ordinary plain
papers. Look for papers with the ColorLok logo in a variety of
weights and sizes from major paper manufacturers.

This section contains the following topics:

• Recommended papers for printing and copying
• Recommended papers for photo printing
• Tips for selecting and using media

Recommended papers for printing and copying
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.

Depending on your country/region, some of these papers might not be available.

HP Brochure Paper
HP Superior Inkjet
Paper

These papers are glossy-coated or matte-coated on both sides for
two-sided use. They are the perfect choice for near-photographic
reproductions and business graphics for report covers, special
presentations, brochures, mailers, and calendars.

HP Bright White Inkjet
Paper

HP Bright White Inkjet Paper delivers high-contrast colors and sharp
text. It is opaque enough for two-sided color usage with no show-
through, which makes it ideal for newsletters, reports, and flyers. It
features ColorLok Technology for less smearing, bolder blacks and
vivid colors.

HP Printing Paper HP Printing Paper is a high-quality multifunction paper. It produces
documents that look and feel more substantial than documents
printed on standard multipurpose or copy paper. It features ColorLok
Technology for less smearing, bolder blacks and vivid colors. It is
acid-free for longer lasting documents.

HP Office Paper HP Office Paper is a high-quality multifunction paper. It is suitable for
copies, drafts, memos and other everyday documents. It features
ColorLok Technology for less smearing, bolder blacks and vivid
colors. It is acid-free for longer lasting documents

HP Office Recycled
Paper

HP Office Recycled Paper is a high-quality multifunction paper made
with 30% recycled fiber. It features ColorLok Technology for less
smearing, bolder blacks and vivid colors. It is acid-free for longer
lasting documents.

HP Premium
Presentation Paper
HP Professional Paper

These papers are heavy two-sided matte papers perfect for
presentation, proposals, reports and newsletters. They are
heavyweight for an impressive look and feel.

HP Advanced Photo
Paper

This thick photo paper features an instant-dry finish for easy handling
without smudging. It resists water, smears, fingerprints, and humidity.
Your prints have a look and feel comparable to a store processed
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photo. It is available in several sizes, including A4, 8.5 x 11 inch, 10 x
15 cm (4 x 6 inch), 13x18 cm (5 x7 inch) with a glossy finish. It is
acid-free for longer lasting documents.

HP Everyday Photo
Paper

Print colorful, everyday snapshots at a low cost, using paper
designed for casual photo printing. This affordable, photo paper dries
quickly for easy handling. Get sharp, crisp images when you use this
paper with any inkjet printer. Available in semi-gloss finish in 8.5 x11
inch, A4, 4 x 6 inch and 10 x 15 cm. It is acid-free for longer lasting
documents.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
select your country/region, follow the prompts to select your printer, and then click one
of the shopping links on the page.

NOTE: At this time, some portions of the HP Web site are available in English
only.

Recommended papers for photo printing
If you want the best print quality, HP recommends using HP papers that are specifically
designed for the type of project you are printing.
Depending on your country/region, some of these papers might not be available.

HP Advanced Photo Paper
This thick photo paper features an instant-dry finish for easy handling without
smudging. It resists water, smears, fingerprints, and humidity. Your prints have a look
and feel comparable to a store processed photo. It is available in several sizes,
including A4, 8.5 x 11 inch, 10 x 15 cm (4 x 6 inch), 13 x 18 cm (5 x 7 inch) and two
finishes – glossy or soft gloss (satin matte). It is acid-free for longer lasting documents.

HP Everyday Photo Paper
Print colorful, everyday snapshots at a low cost, using paper designed for casual photo
printing. This affordable, photo paper dries quickly for easy handling. Get sharp, crisp
images when you use this paper with any inkjet printer. Available in semi-gloss finish in
8.5 x 11 inch, A4, 4 x 6 inch and 10 x 15 cm. It is acid-free for longer lasting
documents.

HP Photo Value Packs
HP Photo Value Packs conveniently package original HP ink cartridges and HP
Advanced Photo Paper to save you time and take the guesswork out of printing
affordable professional photos with your HP printer. Original HP inks and HP Advanced
Photo Paper have been designed to work together so your photos are long lasting and
vivid, print after print. Great for printing out an entire vacation’s worth of photos or
multiple prints to share.

To order HP papers and other supplies, go to www.hp.com/buy/supplies. If prompted,
select your country/region, follow the prompts to select your printer, and then click one
of the shopping links on the page.

NOTE: At this time, some portions of the HP Web site are available in English
only.

Chapter 1
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Tips for selecting and using media
For the best results, observe the following guidelines.

• Always use media that conforms to the printer specifications. For more
information, see Media specifications.

• Load only one type of media at a time into the input tray.
• When loading the input tray or scanner, make sure the media is loaded correctly.

For more information, see Load media or Load an original in the scanner.
• Do not overload the input tray or scanner. For more information, see Media

specifications.
• To prevent jams, poor print quality, and other printing problems, avoid loading the

following media in the input tray or scanner:
◦ Multipart forms
◦ Media that is damaged, curled, or wrinkled
◦ Media with cutouts or perforations
◦ Media that is heavily textured, embossed, or does not accept ink well
◦ Media that is too lightweight or stretches easily
◦ Media that contains staples or clips

• Do not leave photo paper in the input tray for extended periods of time.

Load an original in the scanner
You can copy or scan documents by placing them in the scanner.

CAUTION: Do not load photos in the scanner; this might cause damage to the
photos. Use only media that is supported by the printer. For more information, see
Media specifications.

NOTE: The scanner can hold only 1 sheet of plain paper at a time. To scan
multiple pages, wait for the printer to finish scanning the page, and then load the
next page into the scanner.

To load an original in the scanner
Use these steps to load a document in the scanner.

1. Insert the original, print-side down, into the scanner along the right edge, so that
the top edge of the original goes in first.

CAUTION: Only insert one page at a time into the scanner. Inserting more
than one page can cause jams and possibly damage your original.

Load an original in the scanner 17
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2. Slide the original into the scanner until the scanner grips the page and you hear a
tone and see a message on the display indicating that the loaded page was
detected.

3. Slide the guide until it touches the edge of the original.

Load media
This section provides instructions for loading media into the printer.

CAUTION: Use only media that is supported by the printer. For more information,
see Media specifications.

This section contains the following topics:

CAUTION: Do not load media while the printer is printing.

• Load standard-size media
• Load envelopes
• Load cards and photo paper
• Load custom-size media

Chapter 1

18 Get started



Load standard-size media

To load media
Use these instructions to load standard media.

1. Lift the input tray.
2. Lift up the control panel using the control panel latch.

A5

B5

A4
LTRLGL

3. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger-sized media, pull up the input tray extension.

Load media 19



4. Insert the plain paper print-side up and align it squarely against the paper guide.

LTR
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B5

A4LGL

NOTE: Do not load paper while the printer is printing.

5. Adjust the paper width guide so it fits snugly against the sides of the paper.

Chapter 1
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Load envelopes

To load envelopes
Use these instructions to load an envelope

1. Lift the input tray.
2. Lift up the control panel using the control panel latch.

A5

B5
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3. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger-sized media, pull up the input tray extension.
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4. Load envelopes according to the graphic in the tray.
5. Adjust the width guide so it fits snugly against the sides of the envelope.

A4

A5

B5

LTRLGL

Load cards and photo paper
To load cards and photo paper
Use these instructions to load photo paper.

1. Lift the input tray.
2. Lift up the control panel using the control panel latch.

A5

B5

A4
LTRLGL
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3. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger-sized media, pull up the input tray extension.

4. Insert the media print-side up and align it squarely against the paper guide. If the
photo paper has a tab along one edge, make sure the tab is pointing up.

NOTE: Do not load paper while the printer is printing.

5. Adjust the paper width guide so it fits snugly against the sides of the paper.

Load custom-size media

To load cards and photo paper
Use these instructions to load custom-size media.

CAUTION: Use only custom-size media that is supported by the printer. For more
information, see Media specifications.

1. Lift the input tray.
2. Lift up the control panel using the control panel latch.

A5

B5

A4
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3. Slide the paper width guide out as far as possible.

NOTE: If you are loading larger-sized media, pull up the input tray extension.
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4. Insert the media print-side up and align it squarely against the paper guide.

NOTE: Do not load paper while the printer is printing.

5. Adjust the paper width guide so it fits snugly against the sides of the paper.

Install and use the battery
The printer comes with a lithium-ion rechargeable battery. It is also available for
purchase as an optional accessory. For more information, see HP supplies and
accessories.

This section contains the following topics:

• Battery safety
• Understand the battery
• Charge and use the battery

Battery safety
• Use only the battery designed specifically for the printer. For more information,

see HP supplies and accessories and Printer specifications.
• When discarding a battery, contact your local waste disposal provider regarding

local restrictions on the disposal or recycling of batteries. Though the lithium-ion
rechargeable battery is mercury-free, it might require recycling or proper disposal
at end-of-life. For more information, see Recycling program.

• The battery might explode if incorrectly replaced or disposed of in fire. Do not
short-circuit the battery.

• To purchase a replacement battery, contact your local dealer or HP sales office.
For more information, see HP supplies and accessories.

• To avoid risk of fire, burns, or damage to the battery, do not allow a metal object
to touch the battery contacts.

• Do not disassemble the battery. The battery has no serviceable parts inside.
• Handle a damaged or leaking battery with extreme care. If you come in contact

with the electrolyte, wash the exposed area with soap and water. If it contacts the
eye, flush the eye with water for 15 minutes and seek medical attention.

• Do not charge, store, or use the battery in places where the temperature exceeds
the limits specified in Operating environment.

Important notes
Take note of the following when charging or using the battery:

• Charge the battery for 4 hours before using the battery for the first time. For
subsequent charges, it takes approximately 3 hours to fully charge the battery.

• The battery charge light is amber when the battery is charging. If it is red, the
battery might be faulty and need to be replaced.

• To see battery status, touch Power Meter on the control-panel display. The
battery status is also displayed in Toolbox (Windows) and HP Utility (Mac OS X).
If you are using a Microsoft Windows Mobile® device, you can use the Toolbox
software for PDAs. For more information, see Printer management tools.
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• If the battery is running low, either plug in the AC adapter to charge it or replace
the battery with one that is charged.

• A fully charged battery can print up to approximately 500 pages, scan up to
approximately 140 pages, or copy approximately 100 pages, depending on the
complexity of the jobs.

• By default, the printer goes into Sleep mode to conserve the battery if left idle for
5 minutes on battery power. You can configure this feature from the printer
control panel.

• Prior to long-term storage, fully charge the battery. Do not leave the battery in a
discharged (empty) state for more than 6 months.

• To maximize battery life and capacity, charge, store, and use the battery in
places that meet the guidelines specified in Operating environment.

Understand the battery

1 Battery – Supplies power to the printer.

2 Battery release slider – Slides to release the battery.

Charge and use the battery

WARNING! Charge the battery for 4 hours before using the battery for the first
time. Because the battery is normally warm while it is charging, do not charge it in a
briefcase or other confined space as this might cause the battery to overheat.

NOTE: The AC adapter is normally warm to the touch when plugged into an AC
outlet.

NOTE: Bluetooth printing uses more battery power than wired printing. For
information on checking the battery charge level, see Install and use the battery.

To install the battery

NOTE: You can install the battery with the printer turned on or off.
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1. Slide the battery into the battery slot at an angle, until the contacts on the battery
are flush with the contacts in the battery slot. The battery contact cover slides
open.

2. Push the battery into the battery slot until the battery clicks into place.
3. Plug in the AC adapter and turn on the printer. Allow the battery to charge for four

hours before using the battery for the first time.
4. After the battery is fully charged, you can use the printer without connecting to the

AC power supply.

To remove the battery
Follow these instructions to remove the battery.

1. Slide the battery release slider in the direction of the arrow.
2. Remove the battery.

Insert a memory device
If your digital camera uses a memory card to store photos, you can insert the memory
card into the printer to print or save your photos.
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Using the USB port on the back of the printer, you can connect a USB storage device,
or you can connect and print photos from a PictBridge-compatible camera. You can
also transfer files from the storage device to your computer.

CAUTION: Attempting to remove a memory device while it is being accessed can
damage files on the memory device. You can safely remove a memory card only
when the photo light is not blinking.

NOTE: The printer does not support encrypted memory devices.

For more information on the supported memory devices, see Memory device
specifications.

To insert a memory card
1. Turn the memory card so that the label faces up.
2. Insert the memory card into the memory card slot on the left side of the printer

until it snaps into place.

TIP: To remove a memory card, push in the card and then release it.

To connect a storage device
▲ Insert the USB storage device or the other end of the camera’s USB cable to the

USB port at the back of the printer.
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NOTE: If you are connecting a digital camera, change the USB mode of the
camera to storage mode, and then connect one end of the USB cable to the
camera. Different cameras use different terms to describe the storage mode. For
instance, some cameras have a digital camera setting and a disk drive setting. In
this instance, the disk drive setting is the storage mode setting. If storage mode
does not work on your camera, you might need to upgrade the camera firmware.
For more information, see the documentation that came with the camera.

NOTE: If your USB device does not fit into this port due to size limitations, or if the
connector on the device is shorter than 11 mm (0.43 in), you will need to purchase
a USB extension cable in order to use your device with this port. For more
information on supported USB devices, see Memory device specifications.

Print from mobile phones
If you have a mobile phone that supports Bluetooth, you can purchase software that
allows you to print documents and photos from your phone.

NOTE: If you are using a mobile phone running Windows Mobile, you can use the
HP software CD to install the printing software.

For a list of mobile phones and printing software, as well as information about obtaining
the software, see Mobile phone printing information.

Maintain the printer
The printer does not require scheduled maintenance, except for replacing the ink
service module. For more information, see Replace the ink service module. You should
attempt, however, to keep the printer free of dust and debris. This cleaning keeps the
printer in peak condition and might also make the diagnosis of problems easier.

WARNING! Turn off the printer and unplug the power cord before cleaning the
printer. If using the optional battery, turn off the printer and remove the battery
before cleaning.

This section covers the following topics:

• Clean the printer
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Clean the printer
When you clean the printer, follow these guidelines:

• Clean the outside of the printer with a soft cloth moistened with mild detergent
and water.

NOTE: Clean the printer only with water or water mixed with a mild
detergent. Using other cleaners or alcohol can damage the printer.

• Clean the inside of the cartridge access door with a dry, lint-free cloth.

CAUTION: Be careful not to touch the rollers. Skin oils on the rollers can
cause print quality problems.

Turn off the printer
Turn off the printer by pressing  (Power) located on the printer. Wait until the power
light turns off before unplugging the power cord or turning off a power strip. If you turn
off the printer incorrectly, the print carriage might not return to the correct position,
which might cause print quality issues or problems with the ink cartridges.

NOTE: Wait for the printer to completely shutdown before removing the power
cord from a surge protector or wall outlet, or removing the battery pack.

If you do not shut down the printer in this manner, the next time you start the printer, an
error message will show on the control panel display.
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2 Print
Most print settings are automatically handled by the software application. Change the
settings manually only when you want to change print quality, print on specific types of
paper, change media size, or use special features. For more information about
selecting the best print media for your documents, see Select print media.

This section contains the following topics:

• Print documents
• Print brochures
• Print on envelopes
• Print a Web page
• Print photos
• Print on special and custom-size paper
• Print borderless documents
• Print on both sides (duplexing)

Print documents
NOTE: With certain types of paper, you can print on both sides of a sheet of paper
(called “two-sided printing” or “duplex printing”). For more information, see Print on
both sides (duplexing).

Follow the instructions for the operating system.

• Print documents (Windows)
• Print documents (Mac OS X)

Print documents (Windows)
1. Load paper in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on the software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Change the paper orientation on the Layout tab, and paper source, media type,
paper size, and quality settings on the Paper/Quality tab. To print in black and
white, click the Advanced button, and then change the Print in Grayscale
option.

6. Click OK.
7. Click Print or OK to begin printing.
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Print documents (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the paper size from the Paper Size pop-up menu (if available).
6. Change the print settings for the option provided in the pop-up menus, as

appropriate for your project.

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Click Print to begin printing.

Print brochures
Follow the instructions for the operating system.

• Print brochures (Windows)
• Print brochures (Mac OS X)

Print brochures (Windows)

NOTE: To set print settings for all print jobs, make the changes in the HP software
provided with the printer. For more information on the HP software, see Printer
management tools.

1. Load paper in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Select the printer you want to use.
4. To change settings, click the button that opens the Properties dialog box.

Depending on the software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Select a size from the Size drop-down menu. Select a brochure type from the
Paper Type drop-down menu.

6. Change any other print settings.

TIP: You can change more options for the print job by using the features
available on the other tabs in the dialog box.

7. Click Print to begin printing.
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Print brochures (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the paper size from the Paper Size pop-up menu (if available).
6. Click Paper Type/Quality from the pop-up menu, and then select the following

settings:
• Paper Type: The appropriate brochure paper type
• Quality: Normal or Best

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Select any other print settings that you want, and then click Print to begin
printing.

Print on envelopes
When you select envelopes, avoid envelopes that have a very slick finish, self-stick
adhesives, clasps, or windows. Also, avoid envelopes with thick, irregular, or curled
edges, or areas that are wrinkled, torn, or otherwise damaged.

Make sure the envelopes you load in the printer are tightly constructed and that the
folds are sharply creased.

NOTE: For more information about printing on envelopes, see the documentation
available with the software program you are using.

Follow the instructions for the operating system.

• Print on envelopes (Windows)
• Print on envelopes (Mac OS X)

Print on envelopes (Windows)
1. Load envelopes in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Select the printer you want to print to.
4. To change settings, click the button that opens the Properties dialog box.

Depending on the software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. On the Features tab, change the orientation to Landscape.
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6. In the Basic Options area, from the Size drop-down list, select More. Then,
select the appropriate envelope type.

TIP: You can change more options for the print job by using the features
available on the other tabs in the dialog box.

7. Click OK, and then click Print or OK to begin printing.

Print on envelopes (Mac OS X)
1. Load envelopes in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the appropriate envelope size from the Paper Size pop-up menu,
and then click OK.

3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the appropriate envelope size in the Paper Size pop-up menu (if

available).
6. Select the Orientation option.

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Select any other print settings that you want, and then click Print to begin
printing.

Print a Web page
TIP: To print Web pages correctly, you might need to set the print orientation to
Landscape.

NOTE: With certain types of paper, you can print on both sides of a sheet of paper
(called “two-sided printing” or "duplex printing"). For more information, see Print on
both sides (duplexing).

Follow the instructions for your operating system.

• Print a Web page (Windows)
• Print a Web page (Mac OS X)

Print a Web page (Windows)
If you are using a computer running Windows and Internet Explorer 6.0 or higher for
Web browsing, you can use HP Smart Web Printing to ensure simple, predictable Web
printing with control over what you want and how you want it printed. You can access
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HP Smart Web Printing from the toolbar in Internet Explorer. For more information
about HP Smart Web Printing, see the help file provided with it.

1. Load paper in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Make sure the printer you want to use is selected.
4. If your Web browser supports it, select the items on the Web page that you want

to include in the printout.
For example, in Internet Explorer, click the Options tab to select options such as
As laid out on screen, Only the selected frame, and Print all linked
documents.

5. Click Print or OK to begin printing.

Print a Web page (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the paper size from the Paper Size pop-up menu (if available).
6. Change the print settings for the option provided in the pop-up menus, as

appropriate for your project.

TIP: Some Web browsers include special options for printing Web pages. If
available, select the option for your Web browser from the pop-up menu. For
more information, see the documentation provided with your Web browser.

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Click Print to begin printing.

Print photos
Do not leave unused photo paper in the input tray. The paper might start to curl, which
could reduce the quality of the printout. Photo paper should be flat before printing.

Follow the instructions for the operating system.

• Print photos on photo paper (Windows)
• Print photos on photo paper (Mac OS X)
• Print photos from a memory device

Print photos 35



Print photos on photo paper (Windows)
1. Load paper in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Make sure the printer you want to use is selected.
4. To change settings, click the button that opens the Properties dialog box.

Depending on the software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. If you want to print the photo in black and white, click the Features tab and then
change the Print in Grayscale option under Color Options.

6. Click OK, and then click Print or OK to begin printing.

Print photos on photo paper (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the appropriate paper size from the Paper Size pop-up menu (if available).
6. Click Paper Type/Quality from the pop-up menu, and then select the following

settings:
• Paper Type: The appropriate photo paper type
• Quality: Best or Maximum dpi

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. If necessary, change the photo and color options:
a. Click the disclosure triangle beside Color Options and select the

appropriate Photo Fix options:
• Off: Applies no automatic adjustments to the image.
• Basic: Automatically focuses the image; moderately adjusts image

sharpness.
b. To print the photo in black and white, click Grayscale from the Color pop-

up menu, and then select one of the following options:
• High Quality: Uses all the available colors to print your photo in

grayscale. This creates smooth and natural shades of gray.
• Black Print Cartridge Only: Uses black ink to print your photo in

grayscale. The gray shading is created by varying patterns of black
dots, which might result in a grainy image.

8. Select any other print settings that you want, and then click Print to begin
printing.
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Print photos from a memory device 
You can insert supported memory cards into the slot located on the left side of the
printer. In addition, you can connect a USB storage device (such as a keychain drive or
portable hard drive) to the USB port at the back of the printer. You can also connect a
digital camera in storage mode to the USB port at the back of the printer and print
photos directly from the camera.
For more information about using memory devices, see Insert a memory device.

CAUTION: Attempting to remove a memory device while it is being accessed can
damage files on the memory device. You can safely remove a memory card only
when the status light is not blinking.

To print selected photos

NOTE: This function is only available if the memory device does not contain
Digital Print Order Format (DPOF) content.

1. Insert your memory device into the appropriate slot on the printer. The Photo
screen appears on the control panel display.

2. Touch View & Print. The photos are displayed.
3. Follow the instructions on the control panel display to select, edit, or print the

photos.

Print on special and custom-size paper
If your application supports custom-size paper, set the size in the application before
printing the document. If not, set the size in the print driver. You might need to reformat
existing documents to print them correctly on custom-size paper.

Use only custom-size paper that is supported by the printer. For more information, see
Media specifications.

NOTE: Defining custom-size media sizes is only available in the HP printing
software in Mac OS X.

Follow the instructions for your operating system.

• Print on special or custom-size paper (Mac OS X)

Print on special or custom-size paper (Mac OS X)

NOTE: Before you can print on custom-size paper, you must set up the custom
size in the HP software provided with the printer. For instructions, see Set up
custom sizes (Mac OS X).
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1. Load the appropriate paper in the tray. For more information, see Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.
3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the appropriate paper size from the Paper Size pop-up menu (if available).
6. Click Paper Handling from the pop-up menu.
7. Under Destination Paper Size, click Scale to fit paper size, and then select the

custom size.
8. Select any other print settings that you want, and then click Print to begin

printing.

Set up custom sizes (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. From the File menu in your software application, click Page Setup, and then

make sure the printer you want to use is selected in the Format For pop-up
menu.
- OR -
From the File menu in your software application, click Print, and then make sure
the printer you want to use is selected.

3. Select Manage Custom Sizes in the Paper Size pop-up menu.

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

4. Click the + on the left side of the screen, double-click Untitled, and type a name
for the new, custom size.

5. In the Width and Height boxes, type the dimensions, and then set the margins, if
you want to customize them.

6. Click OK.

Print borderless documents
Borderless printing lets you print to the edges of certain photo media types and a range
of standard media sizes up to 4 x 6 inches (102 x 152 mm).

NOTE: You cannot print a borderless document if the paper type is set to Plain
paper.

NOTE: Before printing a borderless document, open the file in a software
application and assign the image size. Make sure the size corresponds to the
media size on which you are printing the image.
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NOTE: Not all applications support borderless printing.

Follow the instructions for the operating system.

• Print borderless documents (Windows)
• Print borderless documents (Mac OS X)

Print borderless documents (Windows)
1. Load paper in the tray. For more information, see Load media.
2. On the File menu in the software application, click Print.
3. Select the printer you want to print to.
4. To change settings, click the button that opens the Properties dialog box.

Depending on the software application, this button might be called Properties,
Options, Printer Setup, Printer, or Preferences.

5. Click the Features tab.
6. In the Size list, click More, and then select the borderless size loaded in the tray.

If a borderless image can be printed on the specified size, the Borderless check
box is selected.

7. In the Paper type drop-down list, click More, and then select the appropriate
paper type.

8. Select the Borderless check box if it is not already checked.
If the borderless paper size and paper type are not compatible, the printer
software displays an alert and allows you to select a different type or size.

9. Click OK, and then click Print or OK to begin printing.

Print borderless documents (Mac OS X)
1. Load paper in the tray. For more information, see Load media.
2. Select a borderless paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select an available borderless paper size from the Paper Size pop-up
menu, and then click OK.

3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the paper size from the Paper Size pop-up menu (if available).
6. Click Paper Type/Quality from the pop-up menu, and then select the following

settings:
• Paper Type: The appropriate paper type
• Quality: Best or Maximum dpi

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Make sure the Print Borderless check box is selected.
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8. If necessary, click the disclosure triangle beside Color Options and select the
appropriate Photo Fix options:
• Off: Applies no automatic adjustments to the image.
• Basic: Automatically focuses the image; moderately adjusts image

sharpness.
9. Select any other print settings that you want, and then click Print to begin

printing.

Print on both sides (duplexing)
You can print on both sides manually using the Windows printer software.

You can print on both sides of a sheet using a Macintosh computer by first printing the
odd-numbered pages, turning the pages over, and then printing the even-numbered
pages.

• To perform duplexing (Windows)
• To perform duplexing (Mac OS X)

To perform duplexing (Windows)
1. Load the appropriate media. See Guidelines for two-sided (duplex) printing and

Load media.
2. With a document open, on the File menu, click Print, and then click Properties.
3. Click the Features tab.
4. Select Manually from the two-sided printing drop-down list.
5. To automatically resize each page to match the document's onscreen layout,

ensure Preserve Layout is selected. Clearing this option might result in
unwanted page breaks.

6. Select or clear the Flip Pages Up check box to match the way you want the
binding. See the graphics in the print driver for examples.

7. Change any other desired settings and click OK.
8. Print the document.
9. After the first side of the document is printed, follow the onscreen instructions and

reload the paper into the tray to complete printing.
10. After reloading the paper, click Continue in the onscreen instructions to continue

the print job.

To perform duplexing (Mac OS X)
1. Load the appropriate media. For more information, see Guidelines for two-sided

(duplex) printing and Load media.
2. Select a paper size:

a. From the File menu in your software application, click Page Setup.

NOTE: If you do not see a Page Setup menu item, go to step 3.

b. Make sure the printer you want to use is selected in the Format For pop-up
menu.

c. Select the paper size from the Paper Size pop-up menu, and then click OK.

Chapter 2

40 Print



3. From the File menu in your software application, click Print.
4. Make sure the printer you want to use is selected.
5. Select the paper size from the Paper Size pop-up menu (if available).
6. Click the Paper Handling pop-up menu, select Odd Only in the Pages to Print

pop-up menu, and then click Print .

NOTE: If you do not see any options, click the disclosure triangle next to the
Printer pop-up menu or click Show Details.

7. Flip the paper over and then print the even-numbered pages.
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3 Scan
You can use the printer’s control panel to scan documents and other originals and
send them to a variety of destinations, such as a folder on a computer. You can also
scan these originals from your computer using either the HP software provided with the
printer or TWAIN-compliant or WIA-compliant programs.

You can use the HP software on your computer to convert the text in scanned
documents into a format that you can search, copy, paste, and edit.

NOTE: Some scan functions are only available after you install the HP software.

NOTE: Scan functions are supported only through a USB connection. Scan
functions are not available through a Bluetooth connection.

NOTE: For better scan quality, use color scan and avoid scanning under direct
sunlight or intense light.

This section contains the following topics:

• Scan an original
• Scanning documents as editable text

Scan an original
NOTE: Your printer and computer must be connected and turned on.

NOTE: If you are scanning an original from the printer control panel or from your
computer using a the HP printer software, the HP software provided with the printer
must also be installed and running on your computer prior to scanning.

This section contains the following topics:

• Scan to a computer
• Scan to a memory device

Scan to a computer

NOTE: Before scanning to a computer, install the HP software and make sure the
printer is connected to the computer with a USB cable.

NOTE: To scan using HP Scan application or TWAIN compliant software, full HP
software needs to be installed.
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To scan an original to a computer from the printer control panel
Use these steps to scan from the control panel.

1. Insert the original in the scanner. For more information, see Load an original in
the scanner.

2. Touch Scan, and then select Scan To computer.

NOTE: If you are using a computer running Mac OS X, make sure you quit
the HP Scan application before scanning from the printer control panel.

3. Touch the type of document you want to save.
4. Touch Start Scan.

To scan an original from HP printer software
1. Insert the original in the scanner. For more information, see Load an original in

the scanner.
2. On the computer, open the HP scanning software:

• Windows: From the computer desktop, click Start, select Programs or All
Programs, select the folder for your HP printer, select HP Scan, and then
select the scan shortcut you want to use.

• Mac OS X: Double-click the HP Scan 3 icon. This icon is located in the
Hewlett-Packard folder in the Applications folder at the top level of the
hard disk.

TIP: To scan and send documents as email attachments on a computer
running Windows, select Attach to E-mail from the Scan Shortcuts list, and
then follow any onscreen instructions. Also, be sure you have already set up a
valid e-mail account.

3. To start the scan, click Scan.

NOTE: For more information, see the online Help provided with the scanning
software.

NOTE: Use the HP software to scan documents into editable text, a format
that allows you to search, copy, paste, and edit within the scanned document.
Use this format to edit letters, newspaper clippings, and many other
documents. For more information, see Scanning documents as editable text.

Scan to a memory device

NOTE: To scan to a memory device, you do not need to install the HP software or
connect the printer to a computer.

To scan an original to a memory device from the printer control panel
Use these steps to scan an original to a memory device.

1. Insert your original print-side down in the scanner. For more information, see
Load an original in the scanner.

2. Insert a memory device. For more information, see Insert a memory device.
3. Touch Scan, and then touch Memory Card or USB Drive.
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4. Touch Document Type to select the type of document you want to save. Make
changes to scan options, if needed.
Touch Resolution if you want to change the output quality.

5. Touch Start Scan.

Scanning documents as editable text
When scanning documents, you can use the HP software to scan documents into a
format that you can search, copy, paste, and edit. This allows you to edit letters,
newspaper clippings, and many other documents.

This section contains the following topics:

• To scan documents as editable text
• Guidelines for scanning documents as editable text

To scan documents as editable text
Use the following guidelines for scanning documents as editable text.

Follow the instructions for your operating system.

Windows
1. Insert your original print-side down in the scanner. For more information, see

Load an original in the scanner.
2. From the computer desktop, click Start, select Programs or All Programs,

select the folder for your HP printer, and then select HP Scan.
3. Select the type of editable text you want to use in the scan:

I want to... Follow these steps

Extract just the text, without any of the
formatting of the original

Select the Save as Editable Text shortcut
from the list, and then select Text File
(*.txt) from the File Type drop-down menu.

Extract the text, as well as some of the
formatting of the original

Select the Save as Editable Text shortcut
from the list, and then select Rich Text File
(*.rtf) from the File Type drop-down menu.
Or
Select the Save as PDF (searchable)
shortcut from the list, and then select PDF-
Searchable (*.pdf) from the File Type
drop-down menu.

4. To start the scan, click Scan, and then follow the onscreen instructions.

Mac OS X
1. Insert your original print-side down in the scanner. For more information, see

Load an original in the scanner.
2. Double-click the HP Scan 3 icon. This icon is located in the Hewlett-Packard

folder in the Applications folder at the top level of the hard disk.
3. From the HP Scan menu, click Preferences.
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4. Select the Documents preset from the Presets pop-up menu.
5. To start the scan, click Scan.
6. After the scan is complete, click the Save button in the HP Scan toolbar
7. Select the type of editable text you want to use in the scan:

I want to... Follow these steps

Extract just the text, without any of the
formatting of the original

Select TXT from the Format pop-up menu.
Extract the text, as well as some of the
formatting of the original

Extract the text, as well as some of the
formatting of the original

Select RTF or PDF-Searchable from the
Format pop-up menu.

8. Click Save.

Guidelines for scanning documents as editable text
To ensure that the software can convert your documents successfully, do the following:

• Make sure the scanner glass is clean.
When the printer scans the document, smudges or dust on the scanner glass can
be scanned, as well, and can prevent the software from converting the document
to editable text.

• Make sure the document is loaded correctly.
When scanning documents as editable text, the original must be loaded with the
top forward and face up.
Also, make sure the document is not skewed. For more information, see Load an
original in the scanner.

• Make sure the text on the document is clear.
To successfully convert the document to editable text, the original must be clear
and of high quality. The following conditions can cause the software to not
convert the document successfully:
◦ The text on the original is faint or wrinkled.
◦ The text is too small.
◦ The structure of the document is too complex.
◦ The text is tightly spaced. For example, if the text that the software converts

has missing or combined characters, "rn" might appear as "m."
◦ The text is on a colored background. Colored backgrounds can cause

images in the foreground to blend too much.
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• Choose the correct profile.
Be sure to select a shortcut or preset that allows scanning as editable text. These
options use scan settings designed to maximize the quality of your OCR scan. In
Windows, use the Editable Text (OCR) or Save as PDF shortcuts. In Mac OS X,
use the Documents preset.

• Save your file in the correct format.
If you want to extract just the text from the document, without any of the
formatting of the original, select a plain text format (such as Text (.txt) or TXT). If
you want to extract the text, as well as some of the formatting of the original,
select Rich Text Format (such as Rich Text (.rtf) or RTF) or searchable PDF
format (Searchable PDF (.pdf) or PDF-Searchable).
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4 Copy
You can produce high-quality color and black-and-white copies on a variety of paper
types and sizes.

NOTE: For better copy quality, use color copy and avoid copying under direct
sunlight or intense light.

This section contains the following topics:

• Copy documents
• Change copy settings

Copy documents
You can make quality copies from the printer control panel.

To copy documents
1. Make sure you have paper loaded in the input tray.
2. Insert the original in the scanner. For more information, see Load an original in

the scanner.
3. Touch Copy.
4. Touch the left and right arrows to select the number of copies.
5. Touch Settings to change copy settings. For more information, see Change copy

settings
6. To start the copy job, touch one of the following:

• Start Black: To select a black-and-white copy job.
• Start Color : To select a color copy job.

NOTE: If you have a color original, selecting the Black function produces a
black-and-white copy of the color original, while selecting Color produces a
full-color copy of the color original.

Change copy settings
You can customize copy jobs using the various settings available from the printer's
control panel, including the following:

• Copy paper size
• Copy paper type
• Resize copies
• Copy quality
• Lighter/Darker settings
• Set as New Defaults - After making settings changes, touch this to make it the

default for all copies.
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You can use these settings for single copy jobs, or you can save settings to be used as
defaults for future jobs.

To change copy settings for a single job
1. Touch Copy, and then touch Settings .
2. Select the copy function settings you want to change.
3. Touch Start Black or Start Color.

To save the current settings as defaults for future jobs
1. Touch Copy, and then touch Settings.
2. Make any changes to the copy function settings, and then touch Set as new

defaults.
3. Touch Yes.
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5 Work with ink cartridges
This section contains the following topics:

• Information about ink cartridges
• Check the estimated ink levels
• Handle the ink cartridges
• Replace the ink cartridges
• Print with a single ink cartridge
• Store printing supplies
• Ink cartridge maintenance

Information about ink cartridges
The following tips help maintain HP ink cartridges and ensure consistent print quality.

• If you need to replace an ink cartridge, wait until you have the new ink cartridge
available to install before removing the old cartridge.

CAUTION: Do not leave untaped ink cartridges outside of the product for an
extended period of time. This can result in damage to the ink cartridge.

• Keep all ink cartridges in the original sealed packages until they are needed.
• Turn off the printer by pressing the  (Power) button located on the product.

Wait until the power light turns off before unplugging the power cord or turning off
a power strip. If you improperly turn off the printer, the print carriage might not
return to the correct position causing problems with the ink cartridges and print
quality issues. For more information, see Turn off the printer.

• Store ink cartridges at room temperature (15-35° C or 59-95° F).
• You do not need to replace the cartridges until print quality becomes

unacceptable, but a significant decrease in print quality may be the result of one
or more depleted cartridges. Possible solutions include checking the estimated
ink levels remaining in the cartridges, and cleaning the ink cartridges. Cleaning
the ink cartridges uses some ink. For more information, see Advanced ink
cartridge maintenance.

• Do not clean ink cartridges unnecessarily. This wastes ink and shortens the life of
the cartridges.

• Handle ink cartridges carefully. Dropping, jarring, or rough handling during
installation can cause temporary printing problems.

• If you are transporting the product, do the following to prevent ink leaking from
the print carriage or other damage from occurring to the product:
◦ Make sure you turn off the product by pressing the  (Power) button.

The print carriage should be parked on the right side in the service station.
◦ Make sure you leave the ink cartridges installed.

Related topics
Check the estimated ink levels
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Check the estimated ink levels
You can check the estimated ink levels from Toolbox (Windows), HP Utility (Mac OS
X), or the Toolbox software for PDAs. For information about using these tools, see
Printer management tools. You can also print the Printer Status page to view this
information (see Understand the printer information pages).

NOTE: Ink level alerts and indicators provide estimates for planning purposes
only. When you receive a low-ink alert, consider having a replacement cartridge
available to avoid possible printing delays. You do not have to replace the
cartridges until the print quality is unacceptable.

NOTE: If you have installed a refilled or remanufactured cartridge, or a cartridge
that has been used in another printer, the ink level indicator might be inaccurate or
unavailable.

NOTE: Ink from the cartridges is used in the printing process in a number of
different ways, including in the initialization process, which prepares the product
and cartridges for printing, and in printhead servicing, which keeps print nozzles
clear and ink flowing smoothly. In addition, some residual ink is left in the cartridge
after it is used. For more information, see www.hp.com/go/inkusage.

Handle the ink cartridges
Before you replace or clean an ink cartridge, you should know the part names and how
to handle the ink cartridges.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

Hold the ink cartridges by their black plastic sides, with the label on top. Do not touch
the copper-colored contacts or the ink nozzles.
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NOTE: Handle the ink cartridges carefully. Dropping or jarring cartridges can
cause temporary printing problems, or even permanent damage.

Replace the ink cartridges
You can check the estimated ink levels from Toolbox (Windows), HP Utility (Mac OS),
or the Toolbox software for PDAs (Microsoft Windows Mobile). For information about
using these tools, see Printer management tools. You can also print the self-test
diagnostic page to view this information (see Understand the printer information
pages).

NOTE: The ink levels shown are an estimate only. Actual ink volumes might vary.

After removing a cartridge from its package, install it right away. Do not remove a
cartridge from the printer for long periods of time.

To find out which ink cartridges work with the printer, see Supplies.

CAUTION: To prevent clogs, ink failure, and bad electrical connections, do not
touch the ink cartridge ink nozzles or copper contacts, and do not remove the
copper strips.

To replace the ink cartridges
Follow these instructions to replace an ink cartridge.

1. Remove the new ink cartridge from its package and then pull the colored tab to
remove the protective film from the cartridge.

1 Copper-colored contacts

2 Plastic tape with pink pull tab (must be removed before installing)

3 Ink nozzles under tape

2. With the printer turned on, open the cartridge access door. Wait for the carriage
to stop moving. This should take only a few seconds.

CAUTION: Only remove or install ink cartridges when the ink cartridge
carriage stops moving.
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3. Lift the ink cartridge latch open and gently remove the ink cartridge from its cradle
compartment.

4. Insert the new ink cartridge into its cradle compartment at the same angle at
which you removed the old ink cartridge. Check the symbol on the latch against
the symbol on the ink cartridge to make sure you are inserting the correct ink
cartridge.

5. Close the ink cartridge latch. If the cartridge is inserted correctly, closing the latch
gently pushes the cartridge into its cradle compartment. Press the latch to make
sure it is seated flat on the cartridge.
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6. Close the cartridge access door.
7. Wait for the carriage to complete the ink cartridge initialization routine before

using the printer.

NOTE: Do not open the cartridge access door until the ink cartridge
initialization is complete.

Print with a single ink cartridge
If one of the ink cartridges runs out of ink before you can replace it, you can still print
with a single ink cartridge.

Empty cartridge Cartridges used Output

Black Prints with only the tri-color ink
cartridge

Color and grayscale

Tri-color Prints with only the black or photo ink
cartridge

All documents print in
grayscale

Photo Prints with only the tri-color ink
cartridge

Color and grayscale

NOTE: Printing with one ink cartridge might be slower and the print quality might
be affected. It is recommended to print with both ink cartridges. For borderless
printing, the tri-color ink cartridge must be installed.

Store printing supplies
This section covers the following topics:

• Store ink cartridges

Store ink cartridges
Store an ink cartridge in an airtight container with the print nozzles facing up.

Ink cartridge maintenance
This section contains the following topics:

• Align the ink cartridges
• Calibrate color
• Clean the ink cartridges

Align the ink cartridges
Whenever you install a new ink cartridge, you should align the ink cartridges for the
best possible print quality. If the printout is grainy, has stray dots, jagged edges, or the
ink is bleeding into another color, you can realign them through Toolbox, or HP Utility
(Mac OS). For information about using these tools, see Printer management tools.
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NOTE: Load plain paper into the input tray before aligning the ink cartridges. An
alignment page is printed during the alignment process.

• Printer control panel: Touch the right arrow , touch Setup, touch Tools, and
then select Align Ink Cartridges.

• Toolbox (Windows): Open Toolbox. For more information, see Toolbox
(Windows). Click the Printer Services tab, and then click Align Ink Cartridges
and follow the onscreen instructions.

• HP Utility (Mac OS): Open HP Utility. For more information, see HP Utility (Mac
OS X). Click Align and follow the onscreen instructions.

Calibrate color
If you are not satisfied with the appearance of colors, you can calibrate the colors
manually to ensure the best print quality.

NOTE: Calibrate the color only when the tri-color and photo ink cartridges are
installed together. The photo ink cartridge is available for purchase as an optional
accessory. For more information, see HP supplies and accessories.

NOTE: If you are using a Windows Mobile, you can calibrate the color using the
Toolbox software for PDAs. For more information, see Toolbox software for PDAs
(Microsoft Windows Mobile).

Color calibration balances color tints on printed pages. It is only necessary if:

• Printed colors have visibly shifted toward yellow, cyan or magenta.
• There is a color tinge in the gray shades.

Low ink levels in the ink cartridges might also produce incorrect colors.
• Toolbox (Windows): Open Toolbox. For more information, see Toolbox

(Windows). Click the Printer Services tab, and then click Calibrate Color and
follow the onscreen instructions.

• HP Utility (Mac OS): Open HP Utility. For more information, see HP Utility (Mac
OS X). Click Calibrate Color and follow the onscreen instructions.

Clean the ink cartridges
If printed characters are incomplete, or if dots or lines are missing from the printouts,
you might need to clean the ink cartridges. These are symptoms of clogged ink
nozzles, which can result from prolonged exposure to air.

NOTE: Before you clean the ink cartridges, make sure the ink cartridge ink levels
are not low or empty. Low ink levels can also cause incomplete characters, missing
lines, or dots on the printouts. You can check the ink level of the cartridges from the
printer control panel, the Printer Status tab in Toolbox (Windows), HP Utility (Mac
OS), or the Toolbox software for PDAs. For more information, see Work with ink
cartridges.

This section contains the following topics:

• To clean ink cartridges automatically
• To clean ink cartridges manually
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To clean ink cartridges automatically

NOTE: Clean the ink cartridges only when print quality is poor. Cleaning uses ink
and shortens the life of the ink cartridges. There are three levels of cleaning
available. After one level of cleaning, perform the next level of cleaning only if the
results are not satisfactory.

Control panel
1. Touch right arrow , and then touch Setup.
2. Touch Tools, and then touch Clean Ink Cartridges.
3. Follow the onscreen instructions.

Toolbox (Windows)
1. Open Toolbox. For more information, see Toolbox (Windows).
2. Click the Services tab, click Clean the Print Cartridges, and then follow the

onscreen instructions.

HP Utility (Mac OS X)
1. Open HP Utility. For more information, see HP Utility (Mac OS X).
2. Click Clean and follow the onscreen instructions.

To clean ink cartridges manually
Poor contact between the ink cartridges and the ink cartridge cradles can cause error
messages or affect print quality. When this occurs, try cleaning the electrical contacts
on the ink cartridges and ink cartridge cradles.

NOTE: Before cleaning the ink cartridges manually, remove and reinsert the
cartridges to make sure they are inserted correctly.

1. Turn on the device and open the front access cover.
The print carriage moves to the center of the printer.

2. Wait until the print carriage is idle and silent, and then unplug the power cord
from the back of the device.

3. Lift the ink cartridge latch open and gently remove the ink cartridge from its cradle
compartment.

4. Inspect the ink cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze

any excess water from it.
6. Hold the ink cartridge by its sides.
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7. Clean only the copper-colored contacts. Allow the ink cartridges to dry for
approximately ten minutes.

1 Copper-colored contacts

2 Ink nozzles (do not clean)

8. Insert the ink cartridge into its cradle compartment at the same angle at which
you removed the old ink cartridge.

9. Close the ink cartridge latch. If the cartridge is inserted correctly, closing the latch
gently pushes the cartridge into its cradle compartment. Press the latch to make
sure it is seated flat on the cartridge.

10. Repeat if necessary for the other ink cartridge.
11. Close the front access cover and plug the power cord into the back of the device.
12. Wait for the carriage to complete the ink cartridge initialization routine and return

to the home position at the left side of the printer before using the printer.

NOTE: Do not open the front access cover until the ink cartridge initialization
is complete.

13. Align the ink cartridges. For more information, see Align the ink cartridges.
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6 Solve a problem
This section contains the following topics:

• HP support
• General troubleshooting tips and resources
• Solve printing problems
• Poor print quality and unexpected printouts
• Advanced ink cartridge maintenance
• Solve paper-feed problems
• Solve copy problems
• Solve scan problems
• Troubleshoot installation issues
• Problems setting up Bluetooth communication
• Understand the printer information pages
• Clear jams

HP support

If you have a problem, follow these steps
1. Check the documentation that came with the printer.
2. Visit the HP online support Web site at www.hp.com/support. HP online support

is available to all HP customers. It is the fastest source for up-to-date printer
information and expert assistance and includes the following features:
• Fast access to qualified online support specialists
• Software and driver updates for the HP printer
• Valuable troubleshooting information for common problems
• Proactive printer updates, support alerts, and HP newsgrams that are

available when you register the HP printer
For more information, see Obtain electronic support.

3. Call HP support. Support options and availability vary by printer, country/region,
and language. For more information, see HP support by phone.

Obtain electronic support
To find support and warranty information, go to the HP Web site at www.hp.com/
support. If prompted, choose your country/region, and then click Contact HP for
information on calling for technical support.

This Web site also offers technical support, drivers, supplies, ordering information and
other options such as:

• Access online support pages.
• Send HP an e-mail message for answers to your questions.
• Connect with an HP technician by using online chat.
• Check for HP software updates.
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You can also obtain support from the HP software provided with your computer. For
more information, see Printer management tools.

Support options and availability vary by printer, country/region, and language.

HP support by phone
The phone support numbers and associated costs listed here are those in effect at time
of publication and are applicable only for calls made on a land line. Different rates
might apply for mobile phones.

For the most current HP list of telephone support numbers and call costs information,
see www.hp.com/support.

During the warranty period, you can obtain assistance from the HP Customer Care
Center.

NOTE: HP does not provide telephone support for Linux printing. All support is
provided online at the following web site: https://launchpad.net/hplip. Click Ask a
question to begin the support process.

The HPLIP Web site does not provide support for Windows or Mac OS X. If you are
using these operating systems, see www.hp.com/support.

This section contains the following topics:

• Before you call
• Phone support period
• Telephone support numbers
• After the phone support period

Before you call
Call HP support while you are in front of the computer and the HP All-in-One. Be
prepared to provide the following information:

• Model number (for more information, see Find the printer model number)
• Serial number (located on the back or bottom of the printer)
• Messages that appear when the situation occurs
• Answers to these questions:

◦ Has this situation happened before?
◦ Can you re-create it?
◦ Did you add any new hardware or software to the computer at about the

time that this situation began?
◦ Did anything else occur prior to this situation (such as a thunderstorm or

moving the printer)?

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin
America (including Mexico).
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Telephone support numbers
In many locations, HP provides toll free telephone support during the warranty period.
However, some of the support numbers might not be toll free.
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For the most current list of telephone support numbers, see www.hp.com/support.
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After the phone support period
After the phone support period, help is available from HP at an additional cost. Help
might also be available at the HP online support Web site: www.hp.com/support.
Contact your HP dealer or call the support phone number for your country/region to
learn more about support options.

General troubleshooting tips and resources
NOTE: Many of the steps below require HP software. If you did not install the HP
software, you can install it using the HP software CD included with the printer, or
you can download the software from the HP support Web site:www.hp.com/
support.

Try these when you begin troubleshooting a printing problem.

• For a paper jam, see Clear jams.
• For paper-feed problems, such as the paper skew and paper pick, see Solve

paper-feed problems.
• Make sure that the power light is on and not blinking. When the printer is turned

on for the first time, it takes approximately a minute to initialize it after the ink
cartridges are installed.

• If the power cord is plugged in, make sure that the power cord and other cables
are working and are firmly connected to the printer. Make sure that the printer is
connected firmly to a functioning alternating current (AC) power outlet and is
turned on. For voltage requirements, see Electrical requirements.

• If the printer is using battery power, make sure that the battery has been charged.
For more information, see Charge and use the battery.

• Media is loaded correctly in the input tray and is not jammed in the printer.
• All packing tapes and materials are removed.
• The printer is set as the current or default printer. For Windows, set it as the

default in the Printers folder. For Mac OS X, set it as the default in the Print &
Fax or Print & Scan section of the System Preferences. See the computer's
documentation for more information.

• Pause Printing is not selected if you are using a computer running Windows.
• You are not running too many programs when you are performing a task. Close

programs that you are not using or restart the computer before attempting the
task again.

Troubleshooting topics
• Solve printing problems
• Poor print quality and unexpected printouts
• Solve paper-feed problems
• Solve copy problems
• Solve scan problems
• Troubleshoot installation issues
• Problems setting up Bluetooth communication
• Clear jams
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Solve printing problems
This section contains the following topics:

• The printer shuts down unexpectedly
• All printer lights are on or flashing
• The printer is not responding (nothing prints)
• Printer does not accept ink cartridge
• Printer takes a long time to print
• Blank or partial page printed
• Something on the page is missing or incorrect
• Placement of the text or graphics is wrong

The printer shuts down unexpectedly

Check the power and power connections
• Make sure the printer is connected firmly to a functioning alternating current (AC)

power outlet. For voltage requirements, see Electrical requirements.
• If you are using the battery, make sure it is installed correctly.

All printer lights are on or flashing

A non-recoverable error has occurred
Disconnect all cables (such as power cord and USB cable), remove the battery, wait
about 20 seconds, and then reconnect the cables. If the problem persists, visit the HP
Web site (www.hp.com/support) for the latest troubleshooting information, or printer
fixes and updates.

The printer is not responding (nothing prints)

Check the print queue
A print job might be stuck in the print queue. To fix, open the print queue, cancel the
printing of all documents in the queue, and then reboot the computer. After the
computer reboots, try printing again. See the operating system help for information on
opening the print queue and canceling print jobs.

Check the printer setup
For more information, see General troubleshooting tips and resources.

Check the printer software installation
If the printer is turned off when printing, an alert message should appear on the
computer screen; otherwise, the printer software might not be installed correctly. To
resolve this, uninstall the software completely, and then reinstall the printer software.
For more information, see Uninstall and reinstall the HP software.
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Check the cable connections
Make sure both ends of the USB cable are secure.

Check any personal firewall software installed on the computer
The personal software firewall is a security program that protects a computer from
intrusion. However, the firewall might block communication between the computer and
the printer. If there is a problem communicating with the printer, try temporarily
disabling the firewall. If the problem persists, the firewall is not the source of the
communication problem. Re-enable the firewall.
If disabling the firewall allows you to communicate with the printer, you might want to
assign a static IP address to the printer and re-enable the firewall.

Check the Bluetooth connection
Printing larger files using a Bluetooth wireless connection can sometimes cause the
print job to fail. Try printing a smaller file. For more information, see Set up the printer
for Bluetooth communication.

Printer does not accept ink cartridge

Check the ink cartridge
• Remove and reinstall the ink cartridge.
• Make sure the ink cartridge is intended for use in this printer. For more

information, see Work with ink cartridges.

Clean the ink cartridge manually
Complete the ink cartridge cleaning procedure. For more information, see To clean ink
cartridges manually.

Turn off the printer after removing the ink cartridge
After removing the ink cartridge, turn off the printer, wait about 20 seconds, and turn it
on again without the ink cartridge installed. After the printer has restarted, reinsert the
ink cartridge.

NOTE: Make sure you turn off the printer correctly. For more information, see
Turn off the printer.

Printer takes a long time to print

Check the system resources
• Make sure the computer has enough resources to print the document in a

reasonable amount of time. If the computer meets only the minimum system
requirements, documents might take longer to print. For more information on
minimum and recommended system requirements, see System requirements.

• If the computer is too busy running other programs, documents can print more
slowly. Try closing some programs, and then print the document again.
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Check the printer software settings
Print speed is slower when Best or Maximum dpi is selected as the print quality. To
increase the print speed, select different print settings in the print driver. For more
information, see Print.

Check for radio interference
If the printer is connected using Bluetooth wireless and is printing slowly, then the radio
signal might be weak. For more information, see Set up the printer for Bluetooth
communication.

Check the Bluetooth wireless connection
Printing larger files using a Bluetooth wireless connection can sometimes cause the
print job to fail. Try printing a smaller file. For more information, see Problems setting
up Bluetooth communication.

Blank or partial page printed

Clean the ink cartridge
Complete the ink cartridge cleaning procedure. For more information, see To clean ink
cartridges automatically.

Check the battery charge level
If the printer is using battery power, make sure the battery is charged and functioning
properly. If the battery charge level is critically low, the printer might not print the entire
page before ejecting the page. Plug in the power cord to begin charging the battery.
For more information about using the battery, see Install and use the battery.

Check the media settings
• Make sure you select the correct print quality settings in the print driver for the

media loaded in the input tray.
• Make sure the page settings in the print driver match the page size of media

loaded in the input tray.

Check the Bluetooth connection
Printing larger files using a Bluetooth connection can sometimes cause the print job to
fail. Try printing a smaller file. For more information, see Problems setting up Bluetooth
communication.

More than one page feeds through the printer
For more information on paper-feed problems, see Solve paper-feed problems.

There is a blank page in the file
Check the file to make sure there is no blank page.
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Something on the page is missing or incorrect

Check the ink cartridges
• Check to make sure that both cartridges are installed and functioning correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.

Check the margin settings
Make sure the margin settings for the document do not exceed the printable area of the
printer. For more information, see Set minimum margins.

Check the color print settings
Make sure Print in Grayscale is not selected in the print driver.

Check the printer location and length of USB cable
High electromagnetic fields (such as those generated by monitors, motors, fans, TVs,
and other such printers) can sometimes cause slight distortions to printouts. Move the
printer away from the source of the electromagnetic fields. Also, it is recommended that
you use a USB cable that is less than 3 meters (9.8 feet) long to minimize the effects of
these electromagnetic fields.

Check the PictBridge settings
If printing using a PictBridge device, make sure the media settings in the device are
correct or are defaulting to the current printer settings. If defaulting to the current printer
settings, then check Toolbox (Windows), HP Utility (Mac OS), or Toolbox software for
PDAs (Windows Mobile) to make sure the current printer settings are correct.

Check the borderless print settings
If printing using a PictBridge device, make sure the media settings in the device are
correct or are defaulting to the current printer settings.

Check the Bluetooth connection
Printing larger files using a Bluetooth wireless connection can sometimes cause the
print job to fail. Try printing a smaller file. For more information, see Problems setting
up Bluetooth communication.

Check the mobile phone font
Boxes might appear when trying to print Asian fonts from a mobile phone on printers
purchased outside Asia. Asian fonts for Bluetooth mobile phone printing are supported
only by models purchased in Asia.
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Placement of the text or graphics is wrong

Check how the media is loaded
Make sure the guides fit snugly against the edges of the media, and make sure the
input tray is not overloaded. For more information, see Load media.

Check the media size
• Content on a page might be cut off if the document size is larger than the media

that you are using.
• Make sure the media size selected in the print driver match the size of media

loaded in the input tray.

Check the margin settings
If the text or graphics are cut off at the edges of the page, make sure the margin
settings for the document do not exceed the printable area of the printer. For more
information, see Set minimum margins.

Check the page-orientation setting
Make sure the media size and page orientation selected in the application match the
settings in the print driver. For more information, see Print.

Check the printer location and length of USB cable
High electromagnetic fields (such as those generated by monitors, motors, fans, TVs,
and other such devices) can sometimes cause slight distortions to printouts. Move the
printer away from the source of the electromagnetic fields. Also, it is recommended that
you use a USB cable that is less than 3 meters (9.8 feet) long to minimize the effects of
these electromagnetic fields.

If the above solutions do not work, the problem might be caused by the inability of the
application to interpret print settings correctly. See the release notes for known
software conflicts, refer to the application's documentation, or contact the software
manufacturer for specific help.

Poor print quality and unexpected printouts
Print a print quality page to help solve print quality problems. For more information, see
Understand the printer information pages.

This section covers the following topics:

• General tips
• Meaningless characters print
• Ink is smearing
• Ink is not filling the text or graphics completely
• Output is faded or dull colored
• Colors are printing as black and white
• Wrong colors are printing
• Printout shows bleeding colors
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• Colors do not line up correctly
• Printouts have streaks or lines

General tips

Check the ink cartridges
• Check to make sure that both cartridges are installed and functioning correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.
• Whenever you install a new ink cartridge, you should align the ink cartridges for

the best possible print quality. If the printout is grainy, has stray dots, jagged
edges, or the ink is bleeding into another color, you can realign them through
Toolbox or the print driver (Windows), HP Utility (Mac OS), or the Toolbox
software for PDAs (Windows Mobile). For more information, see Align the ink
cartridges.

• Dropping or subjecting the ink cartridges to impact might cause temporary
missing nozzles in the ink cartridge. To resolve this problem, leave the ink
cartridge in the printer for 2 to 24 hours.

• Use the appropriate ink cartridge for the project. For best results, use the HP
black ink cartridge to print text documents and use the HP photo ink cartridge to
print color or black and white photos.

• Make sure ink cartridges have not been tampered with. Refilling processes and
the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Check the paper quality
The paper might be too moist or too rough. Make sure the media meets HP
specifications, and try to print again. For more information, see Media specifications.

Check the type of media loaded in the printer
Make sure the tray supports the type of media you have loaded. For more information,
see Media specifications.

Check the rollers in the printer
The rollers in the printer might be dirty, causing lines or smudges to appear on the
printout. Turn off the printer, remove the battery, and then disconnect the power cord.
Clean the output rollers in the printer with a lint-free cloth lightly dampened with water,
and then try to print again.

Check the printer location and length of USB cable
High electromagnetic fields (such as those generated by monitors, motors, fans, TVs,
and other such devices) can sometimes cause slight distortions to printouts. Move the
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printer away from the source of the electromagnetic fields. Also, it is recommended that
you use a USB cable that is less than 3 meters (9.8 feet) long to minimize the effects of
these electromagnetic fields.

Check the Bluetooth connection
Printing larger files using a Bluetooth connection can sometimes cause the print job to
fail. Try printing a smaller file. For more information, see Problems setting up Bluetooth
communication.

Meaningless characters print
If an interruption occurs to a job that is printing, the printer might not recognize the rest
of the job.

Cancel the print job and wait for the Home screen to appear on the printer control-
panel display. If the Home screen does not appear, cancel all jobs and wait again.
When the Home screen appears on the printer control-panel display, resend the job. If
prompted by the computer to retry the job, click Cancel.

Check the cable connections
If the printer and computer are connected with a USB cable, the problem might be due
to a poor cable connection.
Make sure the cable connections at both ends are secure. If the problem persists, turn
off the printer, disconnect the cable from the printer, turn on the printer without
connecting the cable, and delete any remaining jobs from the print spooler. When the
Power light is on and not flashing, reconnect the cable.

Check the document file
The document file might be damaged. If you can print other documents from the same
application, try printing a backup copy of the document, if available.

Check the mobile phone font
Boxes might appear when trying to print Asian fonts from a mobile phone on printers
purchased outside Asia. Asian fonts for Bluetooth mobile phone printing are supported
only by models purchased in Asia.

Ink is smearing

Check the print settings
• When you print documents that use a lot of ink or less adsorbent media, allow

more time to dry before handling the printouts. In the print driver, select the Best
print quality, and also increase the ink drying time and reduce the ink saturation
using the ink volume under the advanced features (Windows) or ink features
(Mac OS X). However, note that decreasing ink saturation might give printouts a
"washed-out" quality.

• Color documents that have rich, blended colors can wrinkle or smear when
printed using the Best print quality. Try using another print mode, such as
Normal, to reduce ink, or use HP Premium Paper designed for printing vivid color
documents. For more information, see Print.
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Check the media size and type
• Do not allow the printer to print media that is smaller than the print job. If you are

doing borderless printing, make sure the correct media size is loaded. If you are
using the incorrect size, ink smears might appear on the bottom of subsequent
pages.

• Some types of media do not accept ink well. For these types of media, ink dries
more slowly and smearing might occur. For more information, see Media
specifications.

Ink is not filling the text or graphics completely

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Make sure ink cartridges have not been tampered with. Refilling processes and

the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Check the media type
Some media types are not suitable for use with the printer. For more information, see
Media specifications.

Output is faded or dull colored

Check the print mode
The Draft or Fast mode in the print driver allows you to print at a faster rate, which is
good for printing drafts. To get better results, select Normal or Best. For more
information, see Print.

Check the paper type setting
When printing on special media, select the corresponding media type in the print driver.
For more information, see Print on special and custom-size paper.

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
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• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Make sure ink cartridges have not been tampered with. Refilling processes and

the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Colors are printing as black and white

Check the print settings
Make sure Print in Grayscale is not selected in the print driver. Open the printer
Properties dialog box, click the Features tab, and then make sure that Print in
Grayscale is not selected in the Color options.

Check the ink cartridges
• Check to make sure that both the black and the tri-color ink cartridges are

installed and functioning correctly. For more information, see Print with a single
ink cartridge.

• Ink cartridges might need to be cleaned. For more information, see To clean ink
cartridges automatically.

• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.
• Make sure ink cartridges have not been tampered with. Refilling processes and

the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Wrong colors are printing

Check the print settings
Make sure Print in Grayscale is not selected in the print driver. Open the printer
Properties dialog box, click the Features tab, and then make sure that Print in
Grayscale is not selected in the Color options.

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
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• Try removing and reinstalling the cartridges, making sure they snap firmly into
place. For more information, see Work with ink cartridges.

• Make sure ink cartridges have not been tampered with. Refilling processes and
the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Printout shows bleeding colors

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.
• Make sure ink cartridges have not been tampered with. Refilling processes and

the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Check the media type
Some media types are not suitable for use with the printer. For more information, see
Media specifications.

Colors do not line up correctly

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Ink cartridges might need to be cleaned. For more information, see To clean ink

cartridges automatically.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.
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• Whenever you install a new ink cartridge, you should align the ink cartridges for
the best possible print quality. If the printout is grainy, has stray dots, jagged
edges, or the ink is bleeding into another color, you can realign them through
Toolbox or the print driver (Windows), HP Utility (Mac OS), or the Toolbox
software for PDAs (Windows Mobile). For more information, see Align the ink
cartridges.

• Make sure ink cartridges have not been tampered with. Refilling processes and
the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Check the graphics placement
Use the zoom or print preview feature of the software to check for gaps in the
placement of graphics on the page.

Printouts have streaks or lines

Check the print mode
Try using the Best mode in the print driver. For more information, see Print.

Check the ink cartridges
• Check to make sure that both ink cartridges are installed and functioning

correctly.
• Clean the ink cartridges. For more information, see To clean ink cartridges

automatically or Clean the area around the ink nozzles.
• Ink cartridges might have run out of ink. Replace any empty cartridge.
• Try removing and reinstalling the cartridges, making sure they snap firmly into

place. For more information, see Work with ink cartridges.
• Whenever you install a new ink cartridge, you should align the ink cartridges for

the best possible print quality. If the printout is grainy, has stray dots, jagged
edges, or the ink is bleeding into another color, you can realign them through
Toolbox or the print driver (Windows), HP Utility (Mac OS), or the Toolbox
software for PDAs (Windows Mobile). For more information, see Align the ink
cartridges.

• Make sure ink cartridges have not been tampered with. Refilling processes and
the use of incompatible inks can disrupt the intricate printing system and result in
reduced print quality and damage to the printer or ink cartridge. HP does not
guarantee or support refilled ink cartridges. For ordering information, see HP
supplies and accessories.

Advanced ink cartridge maintenance
This section contains the following topics:

• Clean the ink cartridge contacts
• Clean the area around the ink nozzles
• Replace the ink service module

Chapter 6

74 Solve a problem



Clean the ink cartridge contacts
Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that
nothing is covering the ink cartridge contacts, then reinstall the ink cartridge.

Make sure you have the following materials available:
• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come

apart or leave fibers.

TIP: Coffee filters are lint-free and work well for cleaning ink cartridges.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the ink cartridges).

CAUTION: Do not use platen cleaners or alcohol to clean the ink cartridge
contacts. These can damage the ink cartridge or the printer.

To clean the ink cartridge contacts
1. Turn on the device and open the front access cover.

The print carriage moves to the center of the printer.
2. Wait until the print carriage is idle and silent, and then unplug the power cord

from the back of the device.
3. Lift the ink cartridge latch open and gently remove the ink cartridge from its cradle

compartment.
4. Inspect the ink cartridge contacts for ink and debris buildup.
5. Dip a clean foam rubber swab or lint-free cloth into distilled water, and squeeze

any excess water from it.
6. Hold the ink cartridge by its sides.
7. Clean only the copper-colored contacts. Allow the ink cartridges to dry for

approximately ten minutes.

1 Copper-colored contacts

2 Ink nozzles (do not clean)
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8. Insert the ink cartridge into its cradle compartment at the same angle at which
you removed the old ink cartridge.

9. Close the ink cartridge latch. If the cartridge is inserted correctly, closing the latch
gently pushes the cartridge into its cradle compartment. Press the latch to make
sure it is seated flat on the cartridge.

10. Repeat if necessary for the other ink cartridge.
11. Close the front access cover and plug the power cord into the back of the device.
12. Wait for the carriage to complete the ink cartridge initialization routine and return

to the home position at the left side of the printer before using the printer.

NOTE: Do not open the front access cover until the ink cartridge initialization
is complete.

13. Align the ink cartridges. For more information, see Align the ink cartridges.

Clean the area around the ink nozzles
If the printer is used in a dusty environment, a small amount of debris might
accumulate inside the printer. This debris can include dust, hair, carpet, or clothing
fibers. When debris gets on the ink cartridges, it can cause ink streaks and smudges
on printed pages. Ink streaking can be corrected by cleaning around the ink nozzles as
described here.

NOTE: Clean the area around the ink nozzles only if you continue to see streaks
and smudges on your printed pages after you have already cleaned the ink
cartridges by using the software you installed with the printer. For more information,
see To clean ink cartridges automatically.

Make sure you have the following materials available:

• Dry foam rubber swabs, lint-free cloth, or any soft material that will not come
apart or leave fibers.

TIP: Coffee filters are lint-free and work well for cleaning ink cartridges.

• Distilled, filtered, or bottled water (tap water might contain contaminants that can
damage the ink cartridges).

CAUTION: Do not touch the copper-colored contacts or ink nozzles.
Touching these parts can result in clogs, ink failure, and bad electrical
connections.

To clean the area around the ink nozzles
1. Turn on the printer and open the front access cover.

The print carriage moves to the center of the printer.
2. Wait until the print carriage is idle and silent, and then unplug the power cord

from the back of the device.
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3. Lift the ink cartridge latch open and gently remove the ink cartridge from its cradle
compartment.

NOTE: Do not remove both ink cartridges at the same time. Remove and
clean each ink cartridge one at a time. Do not leave an ink cartridge outside
the printer for more than 30 minutes.

4. Place the ink cartridge on a piece of paper with the ink nozzles facing up.
5. Lightly moisten a clean swab with distilled water, and squeeze any excess water

from it.
6. Clean the face and edges around the ink nozzle area with the swab, as shown

below.

1 Nozzle plate (do not clean)

2 Face and edges around the ink nozzle area

CAUTION: Do not clean the nozzle plate.

7. Insert the ink cartridge into its cradle compartment at the same angle at which
you removed the old ink cartridge.

8. Close the ink cartridge latch. If the cartridge is inserted correctly, closing the latch
gently pushes the cartridge into its cradle compartment. Press the latch to make
sure it is seated flat on the cartridge.

9. Repeat if necessary for the other ink cartridge.
10. Close the front access cover and plug the power cord into the back of the device.
11. Wait for the carriage to complete the ink cartridge initialization routine and return

to the home position at the left side of the printer before using the printer.

NOTE: Do not open the front access cover until the ink cartridge initialization
is complete.

12. Align the ink cartridges. For more information, see Align the ink cartridges.

Replace the ink service module
The replaceable ink service module holds waste ink from the black ink cartridge. When
the ink service module is almost full, the printer prompts you to replace it. When you
are notified by the control panel that the ink service module is full, contact HP support
to obtain a new module. For more information, see HP support. If you have a new ink
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service module, install it immediately by following the instructions that came with the
module.

TIP: When the ink service module is full, the printer stops printing. However, until
the replacement arrives, you can continue printing by removing the black ink
cartridge and printing with just the tri-color ink cartridge. Color results and print
speeds, though, might be affected. For more information about printing with a
single ink cartridges, see Print with a single ink cartridge.

CAUTION: Allowing the ink service module to fill completely can result in black ink
spillage. Take care to avoid spilling the ink in the ink service module. Ink can
permanently stain fabric and other materials.

Solve paper-feed problems
For information on resolving jams, see Clear jams.

This section contains the following topics:

• Media is not supported for the printer
• Media is not picked up
• Media is not coming out correctly
• Pages are skewing
• Multiple pages are being picked up

Media is not supported for the printer
Use only media that is supported for the printer and the tray being used. For more
information, see Media specifications.

Media is not picked up
• Make sure media is loaded in the tray. For more information, see Load media.

Fan the media before loading.
• Make sure the paper guides are snug, but not tight, against the stack.
• Make sure media in the tray is not curled. Uncurl paper by bending it in the

opposite direction of the curl.
• Make sure to fully extend the input tray extension.

Media is not coming out correctly
If printed media stacks up outside the printer, it can prevent media from coming out of
the printer correctly.

Pages are skewing
• Make sure the media loaded in the input tray is aligned to the paper guide.
• Load media into the printer only when it is not printing.
• Make sure to fully extend the input tray extension.
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Multiple pages are being picked up
• Fan the media before loading.
• Make sure the paper guides are snug, but not tight, against the stack.
• Make sure the tray is not overloaded with paper.
• Use HP media for optimum performance and efficiency.

Solve copy problems
If the following topics do not help, see HP support for information about HP support.

• No copy came out
• Copies are blank
• Documents are missing or faded
• Size is reduced
• Copy quality is poor
• Copy defects are apparent
• The printer prints half a page, then ejects the paper
• Paper mismatch

No copy came out
• Check the power

◦ If using AC power, make sure that the power cord is securely connected,
and the printer turned on.

◦ If using a battery, make sure that the battery is charged, and the printer
turned on.

• Check the status of the printer
◦ The printer might be busy with another job. Check the control-panel display

for information about the status of jobs. Wait for any job that is processing to
finish.

◦ The printer might be jammed. Check for jams. See Clear jams.
• Check the input tray

Make sure that media is loaded. See Load media for more information.
• Check the battery charge level

If the printer is using battery power, make sure the battery is charged and
functioning properly. If the battery charge level is critically low, the printer might
not print the entire page before ejecting the page. Plug in the power cord to begin
charging the battery. For more information about using the battery, see Install and
use the battery.
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Copies are blank
• Check the media

The media might not meet HP media specifications (for example, the media is too
moist or too rough). See Media specifications for more information.

• Check the settings
The contrast setting might be set too light. On the printer control panel, touch
Copy, touch Lighter Darker, and then use the arrows to create darker copies.

• Check the scanner
Make sure that the original has been loaded correctly. For more information, see
Load an original in the scanner.

Documents are missing or faded
• Check the media

The media might not meet HP media specifications (for example, the media is too
moist or too rough). See Media specifications for more information.

• Check the settings
The quality setting of Fast (which produces draft-quality copies) might be
responsible for the missing or faded documents. Change to the Normal or Best
setting.

• Check the original
◦ The accuracy of the copy depends on the quality and size of the original.

Use the Copy menu to adjust the brightness of the copy. If the original is
too light, the copy might not be able to compensate, even if you adjust the
contrast.

◦ Colored backgrounds might cause images in the foreground to blend into
the background, or the background might appear in a different shade.

Size is reduced
• The reduce/enlarge or other copy feature might have been set from the printer

control panel to reduce the scanned image. Check the settings for the copy job to
make sure that they are for normal size.

• The HP software settings might be set to reduce the scanned image. Change the
settings, if needed. See the onscreen Help for the HP software for more
information.

Copy quality is poor 
• Take steps to improve the copy quality

◦ Use quality originals.
◦ Load the original correctly. If the original is loaded incorrectly in the scanner,

it might skew, causing unclear images. See Media specifications for more
information.
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◦ Use or make a carrier sheet to protect the originals.
◦ For better copy quality, avoid using the printer under direct sunlight or

intense light.
• Check the scanner

The scanner might need cleaning. To clean the scanner, use the cleaning cloth
provided with the printer and see the information provided with the cloth.

Copy defects are apparent
• Vertical white or faded stripes

The media might not meet HP media specifications (for example, the media is too
moist or too rough). See Media specifications for more information.

• Too light or dark
Try adjusting the contrast and copy-quality settings.

• Copy is slanted or skewed
Make sure that the scanner width adjuster is snug against the side of the media.

• Unclear text
◦ Try adjusting the contrast and copy-quality settings.
◦ The default enhancement setting might not be suitable for the job. Check

the setting and change it to enhance text or photographs, if needed. For
more information, see Change copy settings.

• Incompletely filled text or graphics
Try adjusting the contrast and copy-quality settings.

• Large, black typefaces look splotchy (not smooth)
The default enhancement setting might not be suitable for the job. Check the
setting and change it to enhance text or photographs, if needed. For more
information, see Change copy settings.

The printer prints half a page, then ejects the paper

Clean the ink cartridge
Complete the ink cartridge cleaning procedure. For more information, see To clean ink
cartridges automatically.

Check the battery charge level
If the printer is using battery power, make sure the battery is charged and functioning
properly. If the battery charge level is critically low, the printer might not print the entire
page before ejecting the page. Plug in the power cord to begin charging the battery.
For more information about using the battery, see Install and use the battery.

Check the media settings
• Make sure you select the correct print quality settings in the print driver for the

media loaded in the trays.
• Make sure the page settings in the print driver match the page size of media

loaded in the tray.
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More than one page feeds through the printer
For more information on paper-feed problems, see Solve paper-feed problems.

There is a blank page in the file
Check the file to make sure there is no blank page.

Paper mismatch

Check the settings
Verify that the loaded media size and type matches the control panel settings.

Solve scan problems
If the following topics do not help, see HP support for information about HP support.

NOTE: If you are starting the scan from a computer, see the software Help for
troubleshooting information.

• Scanner did nothing
• Scan takes too long
• Part of the document did not scan or text is missing
• Text cannot be edited
• Error messages appear
• Scanned image quality is poor
• Scan defects are apparent

Scanner did nothing
• Check the original

Make sure that the original is loaded correctly. For more information, see Load an
original in the scanner.

• Check the printer
◦ To scan to computer or e-mail, the printer must be connected to the

computer through a USB connection.
◦ The printer might be coming out of Sleep mode after a period of inactivity,

which delays processing a short while. Wait until the Home screen appears
on the printer control-panel display.

• Check the HP software
Make sure the HP software provided with the printer is installed correctly.
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Scan takes too long
Check the settings
◦ If you set the resolution too high, the scan job takes longer and results in larger

files. To obtain good results when scanning or copying, do not use a resolution
that is higher than needed. You can lower the resolution to scan more quickly.

◦ If you acquire an image through TWAIN, you can change the settings so that the
original scans in black and white. See the onscreen Help for the TWAIN program
for information.

Part of the document did not scan or text is missing
• Check the original

◦ Make sure that the original document meets minimum size requirements.
For more information, see Load an original in the scanner.

◦ Make sure that you loaded the original correctly. For more information, see
Load an original in the scanner.

◦ Colored backgrounds can cause images in the foreground to blend into the
background. Try adjusting the settings before you scan the original, or try
enhancing the image after you scan the original.

• Check the settings
◦ Make sure that the input media size is large enough for the original that you

are scanning.
◦ If you are using the HP software provided with the printer, the default

settings in the HP software might be set to automatically perform a specific
task other than the one that you are attempting. See the onscreen Help for
the HP software for instructions about changing the properties.

Text cannot be edited
• Check the settings

◦ When you scan the original, make sure that you select a document type in
the software that creates editable text. If text is classified as a graphic, it is
not converted to text.

◦ If you are using a separate OCR (optical character recognition) program,
the OCR program might be linked to a word-processing program that does
not perform OCR tasks. For more information, see the documentation
provided with the OCR program.

◦ Make sure you have selected an OCR language that corresponds to the
language used for the document you are scanning. For more information,
see the documentation provided with the OCR program.

• Check the originals
◦ When scanning documents as editable text, the original must be loaded into

the scanner with the top forward and face down. Also, make sure the
document is not skewed. For more information, see Load an original in the
scanner.

◦ The software might not recognize text that is tightly spaced. For example, if
the text that the software converts has missing or combined characters, "rn"
might appear as "m."
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◦ The accuracy of the software depends on the image quality, text size, and
structure of the original and the quality of the scan itself. Make sure that
your original has good image quality.

◦ Colored backgrounds can cause images in the foreground to blend too
much.

Error messages appear
• "Unable to activate TWAIN source" or "An error occurred while acquiring

the image"
◦ If you are acquiring an image from another device, such as a digital camera

or another scanner, make sure that the other device is TWAIN-compliant.
Devices that are not TWAIN-compliant do not work with the HP software.

◦ Make sure that you have connected the USB cable to the correct port on the
back of the computer.

◦ Verify that the correct TWAIN source is selected. In the software, check the
TWAIN source by selecting Select Scanner on the File menu.

• Error, The Scan cannot be performed because another program has control
of the HP imaging device
If you are using a computer running Mac OS X, quit the HP Scan application. If
you get the error message again, restart the computer and try to scan again.

Scanned image quality is poor 
The original is a second-generation photo or picture
Reprinted photographs, such as those in newspapers or magazines, are printed by
using tiny dots of ink that make an interpretation of the original photograph, which
degrades the quality. Often, the ink dots form unwanted patterns that can be detected
when the image is scanned or printed or when the image appears on a screen. If the
following suggestions do not solve the problem, you might need to use a better-quality
version of the original.
◦ To eliminate the patterns, try reducing the size of the image after scanning.
◦ Print the scanned image to see if the quality is better.
◦ Make sure that the resolution and color settings are correct for the type of scan

job.
Text or images on the back of a two-sided original appear in the scan
Two-sided originals can "bleed" text or images from the back side to the scan if the
originals are printed on media that is too thin or too transparent.
The scanned image is skewed (crooked)
The original might have been placed incorrectly. Be sure to use the media guide when
you load the original. For more information, see Load an original in the scanner.
The image quality is better when printed
The image that appears on the screen is not always an accurate representation of the
quality of the scan.
◦ Try adjusting the computer monitor settings to use more colors (or levels of gray).

On Windows computers, you typically make this adjustment by opening Display
on the Windows control panel.

◦ Try adjusting the resolution and color settings.
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The scanned image shows blots, lines, vertical white stripes, or other defects
The defects might be on the original and not a result of the scanning process.
Graphics look different from the original
The graphics settings might not be suitable for the type of scan job that you are
performing. Try changing the graphics settings.
• Take steps to improve the scan quality

◦ Use high-quality originals.
◦ Load the original correctly. If the original is loaded incorrectly in the scanner,

it might skew, which causes unclear images. For more information, see
Load an original in the scanner.

◦ Adjust the software settings according to how you plan to use the scanned
page.

◦ Use or make a carrier sheet to protect the originals.
◦ For better scan quality, avoid using the printer under direct sunlight or

intense light.
• Check the scanner

The scanner might need cleaning. To clean the scanner, use the cleaning cloth
provided with the printer and see the information provided with the cloth.

Scan defects are apparent
• Blank pages

Make sure that the original document is loaded correctly. For more information,
see Load an original in the scanner

• Too light or dark
◦ Try adjusting the settings. Be sure to use the correct resolution and color

settings.
◦ The original image might be very light or dark or might be printed on colored

paper.
• Unclear text

Try adjusting the settings. Make sure that the resolution and color settings are
correct.

• Size is reduced
The HP software settings might be set to reduce the scanned image. See the HP
software Help for more information about changing the settings.

Troubleshoot installation issues
If the following topics do not help, see HP support for more information.
• Hardware installation suggestions
• Software installation suggestions
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Hardware installation suggestions

Check the printer
• Make sure that all packing tape and material have been removed from outside

and inside the printer.
• Make sure that the printer is loaded with paper.
• Make sure that no errors on the control panel.

Check the hardware connections
• Make sure that any cords and cables that you are using are in good working

order.
• Make sure that the power cord is connected securely to both the printer and to a

working power outlet. Or, make sure that the battery is correctly installed and
charged.

Check the battery charge level
If the printer is using battery power, make sure the battery is charged and functioning
properly. If the battery charge level is critically low, the printer might not print the entire
page before ejecting the page. Plug in the power cord to begin charging the battery.
For more information about using the battery, see Install and use the battery.

Check the covers
Make sure that all latches and covers are closed correctly.

Software installation suggestions

Check the computer system
• Make sure that the computer is running one of the supported operating systems.
• Make sure that the computer meets at least the minimum system requirements.
• In the Windows device manager, make sure that the USB drivers have not been

disabled.
• If you are using a computer running Windows, and the computer cannot detect

the printer, run the uninstallation utility (util\ccc\uninstall.bat on the HP software
CD) to perform a clean uninstallation of the print driver. Restart the computer, and
reinstall the print driver.

Verify installation preliminaries
• Before installing software, make sure that all other programs are closed.
• If the computer does not recognize the path to the CD-ROM drive that you type,

make sure that you are specifying the correct drive letter.
• If the computer cannot recognize the HP software CD in the CD-ROM drive,

inspect the HP software CD for damage. You can download the print driver from
the HP Web site:www.hp.com/support.

NOTE: After correcting any problems, run the installation program again.
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Problems setting up Bluetooth communication
If you have problems printing using a Bluetooth connection, try the following
suggestions. For more information on configuring wireless settings, see Set up the
printer for Bluetooth communication.

Windows
▲ Check the Bluetooth settings. For more information, see Set up the printer for

Bluetooth communication.

Mac OS
▲ Delete and re-add the printer in Print & Fax or Print & Scan (Mac OS).

Check the Bluetooth settings
• Check the Bluetooth settings. For more information, see Set up the printer for

Bluetooth communication
• To configure Bluetooth settings or monitor printer status (such as ink levels) using

Toolbox (Windows), you must connect the printer to the computer with a USB
cable.

Check the Bluetooth signal
Wireless communication can be interrupted or unavailable if there is signal
interference, distance or signal strength problems, or if the printer is not ready .

• Make sure the printer is within range of the Bluetooth sending device. Bluetooth
printing allows wireless printing up to 10 meters (30 feet).

• If a document doesn't print, there could be signal interruption. If a message
appears on the computer explaining that there is a signal problem, cancel the
print job and then resend it from the computer.

Understand the printer information pages
The printer information pages contain detailed printer information, including firmware
version number, serial number, service ID, print cartridge information, default page
settings, and printer media settings.

NOTE: The printer must not be processing any print jobs while you print the
configuration and diagnostic pages.

If you need to call HP, it is useful to print diagnostic and configuration pages before
calling.
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Print printer information pages
You can print the following printer information pages from the control panel on the
printer, without being connected to the printer.

To print a print quality page
On the printer control panel, touch Setup, touch Reports, and then touch Print
Quality Diagnostic Report.
Use the report to view current print cartridge health, and to troubleshoot printer
problems.

To print a status page
On the printer control panel, touch Setup, touch Reports, and then touch Print Status
Report.
Use the status page to view default page settings and printer media settings.

Clear jams
Occasionally, media becomes jammed during a job. Try the following remedies to
reduce jams.

• Make sure that you are printing with media that meets specifications. For more
information, see Media specifications.

• Make sure that you are printing with media that is not wrinkled, folded, or
damaged.

• Make sure that the input tray is loaded correctly and is not too full. For more
information, see Load media.

• Make sure that the original is loaded correctly. For more information, see Load an
original in the scanner.

This section contains the following topics:

• Clear a jam in the printer
• Tips for avoiding jams

Clear a jam in the printer

To clear a jam
Use these steps to clear a paper jam.

1. Turn off the printer.
2. Unplug the power cord.

NOTE: If using the optional battery, remove the battery. For more
information, see Install and use the battery.

3. Remove media that is not jammed from the input tray and the output slot.

NOTE: Do not put your hands inside the input tray. Use tweezers instead
and be careful not to scratch the inside of the printer.
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4. Locate the media jam.

Jammed media is visible in the output slot
a. Gently pull it toward you and out from the slot. If the media is not visible,

open the cartridge access door and clear jammed media.

NOTE: Remove jammed media slowly and steadily to prevent media
tear.

A5

B5

A4
LTRLGL

b. If the print carriage is obstructing the jam, gently push it to one side and
then remove the media.

c. If the jammed media is not visible in the print area inside the printer, remove
what is visible in the input tray.
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Media is jammed in the scanner
a. Lift the latch to release the scanner glass.

b. Gently pull the media from behind the control panel, up and away from the
printer.

c. After all jammed media is removed from the scanner, gently lift the scanner
glass until it snaps into place.
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5. Plug in the power cord, and then turn on the printer.

NOTE: If using the optional battery, reconnect the battery.

6. Touch OK to continue the current job.
The printer continues the print job on the next page. Resend the page or pages
that were jammed in the printer.

Tips for avoiding jams
• Make sure that nothing is blocking the paper path.
• Do not overload the input tray. For more information, see Media specifications.
• Load paper correctly and when the printer is not printing. For more information,

see Load media.
• Do not use media that is curled or crumpled.
• Always use media that conforms with specifications. For more information, see

Media specifications.
• Make sure media is aligned against the right side of the input tray.
• Make sure the media guides are adjusted snugly against the media, but do not

crinkle or bend it.
• Make sure to remove paper clips, staples, pins, or other attachments from the

paper.
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A Technical information
This section contains the following topics:
• Warranty information
• Printer specifications
• Regulatory information
• Environmental product stewardship program
• Third-party licenses

Warranty information
This section contains the following topics:
• Hewlett-Packard limited warranty statement
• Ink cartridge warranty information
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Hewlett-Packard limited warranty statement

A. Extent of limited warranty
  1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from 

defects in materials and workmanship for the duration specified above, which duration begins on the date of 
purchase by the customer.

  2. For software products, HP’s limited warranty applies only to a failure to execute programming instructions. HP 
does not warrant that the operation of any product will be interrupted or error free.

  3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not 
cover any other problems, including those that arise as a result of:

   a. Improper maintenance or modification;
   b. Software, media, parts, or supplies not provided or supported by HP;
   c. Operation outside the product's specifications;
   d. Unauthorized modification or misuse.
  4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty 

to the customer or any HP support contract with the customer. However, if printer failure or damage is 
attributable to the use of a non-HP or refilled cartridge or an expired ink cartridge, HP will charge its standard 
time and materials charges to service the printer for the particular failure or damage.

  5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

  6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP 
shall, within a reasonable time after being notified of the defect, refund the purchase price for the product.

  7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
  8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of 

the product being replaced.
  9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.
  10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. 

Contracts for additional warranty services, such as on-site service, may be available from any authorized HP 
service facility in countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES 
ANY OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES 
OR CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE.

C. Limitations of liability
  1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole 

and exclusive remedies.
  2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH 

IN THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE 
FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

D. Local law
  1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights 

which vary from state to state in the United States, from province to province in Canada, and from country to 
country elsewhere in the world.

  2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be 
deemed modified to be consistent with such local law. Under such local law, certain disclaimers and limitations 
of this Warranty Statement may not apply to the customer. For example, some states in the United States, as 
well as some governments outside the United States (including provinces in Canada), may:

   a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a 
consumer (e.g., the United Kingdom);

   b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
   c. Grant the customer additional warranty rights, specify the duration of implied warranties which the 

manufacturer cannot disclaim, or allow limitations on the duration of implied warranties.
  3. THE TERMS IN THIS WARRANTY STATEMENT, EXCEPT TO THE EXTENT LAWFULLY PERMITTED, DO 

NOT EXCLUDE, RESTRICT, OR MODIFY, AND ARE IN ADDITION TO, THE MANDATORY STATUTORY 
RIGHTS APPLICABLE TO THE SALE OF THE HP PRODUCTS TO SUCH CUSTOMERS.

HP Limited Warranty

The name and address of the HP entity responsible for the performance of the HP Limited Warranty in your country is as 
follows: 

United Kingdom: Hewlett-Packard Ltd Cain Road Bracknell GB-Berks RG12 1HN 
Eire: Hewlett-Packard Ireland Limited, 63-74 Sir John Rogerson's Quay, Dublin 2 
Malta: Hewlett-Packard International Trade B.V. Malta Branch, 48, Amery Street, Sliema SLM 1701, MALTA

You may have additional statutory rights against the seller based on your purchase agreement. Those rights are not in any 
way affected by this HP Limited Warranty.

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year 
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date 
 printed on the cartridge has been reached, whichever occurs 
 first. This warranty does not cover HP ink products that have 
 been refilled, remanufactured, refurbished, misused, or 
 tampered with.
Printheads (only applies to products with customer 1 year 
replaceable printheads)
Accessories 1 year unless otherwise stated
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Ink cartridge warranty information
The HP cartridge warranty is applicable when the printer is used in its designated HP printer. This
warranty does not cover HP ink products that have been refilled, remanufactured, refurbished,
misused, or tampered with.
During the warranty period the printer is covered as long as the HP ink is not depleted and the
end of warranty date has not been reached. The end of warranty date, in YYYY/MM/DD format,
can be found on the printer as indicated:
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Printer specifications
This section contains the following topics:
• Physical specifications
• Printer features and capacities
• Processor and memory specifications
• System requirements
• Memory device specifications
• Mobile phone printing information
• Media specifications
• Print resolution
• Copy specifications
• Scan specifications
• Operating environment
• Electrical requirements
• Acoustic emission specification

Physical specifications

Size (width x depth x height)
• Printer: 355.6 x 176.5 x 89.5 mm (14.00 x 6.95 x 3.52 inches)
• Printer with battery: 355.6 x 198.5 x 89.5 mm (14.00 x 7.81 x 3.52)

Printer weight (does not include print supplies)
• Printer: 3.0 kg (6.5 lb)
• Printer with battery: 3.1 kg (6.9 lb)

Printer features and capacities

Feature Capacity

Connectivity • USB 2.0-compliant high-speed device
• PictBridge/USB 2.0 high-speed host

port
• Memory cards (Secure Digital, High

Capacity Secure Digital)
• Bluetooth 2.0 Enhanced Data Rate,

backward compatible with 1.0
(Bluetooth Profiles supported: HCRP,
BIP, OPP, SPP)

Ink cartridges Black and tri-color ink cartridge

Supply yields Visit www.hp.com/pageyield/ for more
information on estimated ink cartridge yields.

Printer languages HP PCL 3 GUI

Printer control panel language support
Language availability varies by country/region.

Bulgarian, Croatian, Czech, Danish, Dutch,
English, Finnish, French, German, Greek,
Hungarian, Italian, Japanese, Korean,
Norwegian, Polish, Portuguese, Romanian,
Russian, Simplified Chinese, Slovak,
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Feature Capacity

Slovenian, Spanish, Swedish, Traditional
Chinese, Turkish.

Processor and memory specifications
Processor: 220 MHz ARM9 core
Memory: 64 MB DDR2

System requirements

NOTE: For the most current information about supported operating systems and system
requirements, visit www.hp.com/support.

NOTE: For support information on Microsoft® Windows® 8, visit www.hp.com/go/
printerinstall.

Operating system compatibility
• Mac OS X v10.6, OS X Lion, OS X Mountain Lion
• Microsoft® Windows® 8, Windows® 7, Windows Vista®, Windows® XP (32-bit) Service

Pack 2
• Linux (For more information, see http://hplipopensource.com/hplip-web/index.html.)

Minimum requirements
• Microsoft® Windows® 8: 1 GHz 32-bit (x86) or 64-bit (x64) processor; 2 GB hard disk

space; CD-ROM/DVD drive or Internet connection; USB port
Microsoft® Windows® 7: 1 GHz 32-bit (x86) or 64-bit (x64) processor; 1.1 GB hard disk
space; CD-ROM/DVD drive or Internet connection; USB port

• Microsoft® Windows® Vista: 800 MHz 32-bit (x86) or 64-bit (x64) processor; 1.0 GB hard
disk space; CD-ROM/DVD drive or Internet connection; USB port

• Microsoft® Windows® XP (32-bit) Service Pack 2: Intel® Pentium® II , Celeron® or
compatible processor; 233 MHz or higher; 600 MB hard disk space; CD-ROM/DVD drive or
internet connection; USB port

Memory device specifications

Memory cards
• Specifications

◦ Maximum recommended number of files on a memory device: 1,000
◦ Maximum recommended individual file size: 12 megapixel maximum, 8 MB maximum
◦ Maximum recommended memory device size: 1 GB (solid state only)

NOTE: Approaching any of the recommended maximums on a memory device
might cause the performance of the printer to be slower than expected.

• Supported memory device types
◦ Secure Digital
◦ High Capacity Secure Digital

NOTE: The printer can only read memory devices that have been formatted using the FAT,
FAT32, or EX_FAT file system.

(continued)
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USB flash drives
HP has fully tested the following USB flash drives with the printer:
• Kingston: Data Traveler 100 USB 2.0 flash driver (4 GB, 8 GB, and 16 GB)
• Lexar JumpDrive Traveler: 1 GB
• Imation: 1GB USB Swivel
• SanDisk: Cruzer Micro Skin USB Flash Drive (4 GB)
• HP: HI-SPEED USB Flash Drive v100w (8 GB)

NOTE: You might be able to use other USB flash drives with the printer. However, HP
cannot guarantee that they correct functionality with the printer because they have not been
fully tested.

Mobile phone printing information
The following printing software for this printer is available for these mobile phones:

Mobile phone Software Web site

Windows Mobile* Westtek JETCET http://www.westtek.com/
pocketpc/jetcet/

Blackberry Repligo Professional http://www.cerience.com/
products/pro

* The printing software for Windows Mobile is available on the HP software CD.

Media specifications
Use the Understand supported sizes and Understand supported media types and weights tables
to determine the correct media to use with your printer, and to determine what features work with
the media you plan to use. See the Set minimum margins section for information about the
printing margins used by the printer, see the Guidelines for two-sided (duplex) printing section for
guidelines that should be followed when printing on both sides of a page.
• Understand specifications for supported media
• Set minimum margins
• Guidelines for two-sided (duplex) printing

Understand specifications for supported media
• Understand supported sizes
• Understand supported media types and weights

Understand supported sizes

Media size Input tray Scanner

Standard media sizes

U.S. Letter (216 x 279 mm; 8.5 x 11 inches)

U.S. Legal (216 x 356 mm; 8.5 x 14 inches)

A4 (210 x 297 mm; 8.3 x 11.7 inches)

U.S. Executive (184 x 267 mm; 7.25 x 10.5 inches)
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Media size Input tray Scanner

B5 (JIS) (182 x 257 mm; 7.17 x 10.12 inches)

A5 (148 x 210 mm; 5.8 x 8.3 inches)  

A6 (105 x 148 mm; 4.13 x 5.83 inches)  

U.S. Statement (140 x 216 mm; (5.5 x 8.5 inches)  

Envelopes

U.S. #10 Envelope (105 x 241 mm; 4.12 x 9.5
inches)

 

C5 Envelope (162 x 229 mm; 6.38 x 9.01 inches)  

C6 Envelope (114 x 162 mm; 4.5 x 6.4 inches)  

Japanese Envelope Chou #3 (120 x 235 mm; 4.7 x
9.3 inches)

 

Japanese Envelope Chou #4 (90 x 205 mm; 3.5 x
8.1 inches)

 

Monarch Envelope (3.88 x 7.5 inches)  

A2 Envelope (111 x 146 mm; 4.37 x 5.75 inches)  

DL Envelope (110 x 220 mm; 4.3 x 8.7 inches)  

Cards

Index card (76.2 x 127 mm; 3 x 5 inches)  

Index card (102 x 152 mm; 4 x 6 inches)  

Index card (127 x 203 mm; 5 x 8 inches)  

Photo media 

4 x 6 (102 x 152 mm; 4 x 6 inches) *  

5 x 7 (13 x 18 cm; 5 x 7 inches)  

8 x 10 (8 x 10 inches)  

13 x 18 cm (5 x 7 inches)  

(10 x 15 cm)*  

(10 x 15 cm) tab *  

Photo L (89 x 127 mm; 3.5 x 5 inches) *  

2L (178 x 127 mm; 7.0 x 5.0 inches)  

(continued)
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Media size Input tray Scanner

3.5 x 5 (88.9 x 127 mm)*  

3 x 5 (76.2 x 127 mm)  

8.5 x 13 (215.9 x 330.2 mm)  

4 x 6 tab (102 x 152 mm; 4 x 6 inches) *  

Other media 

Custom-size media between 76.2 to 216 mm wide
and 101 to 355.6 mm long (3 to 8.5 inches wide
and 4 to 14 inches long)

 

Custom-sized media (scanner) between 182 to
216 mm wide and 127 to 356 mm long (7.17 to 8.5
inches wide and 5 to 14 inches long)

 

* Borderless printing supported.

Understand supported media types and weights

Tray Type Weight Capacity

Input tray Paper 60 to 105 g/m2

(16 to 28 lb bond)
Up to 50 sheets of
paper

Photo media 250 g/m2

(66 lb bond)
Up to 5 sheets

Envelopes 75 to 90 g/m2

(20 to 24 lb bond
envelope)

Up to 3 envelopes

Cards Up to 200 g/m2

(110 lb index)
Up to 5 cards

Scanner Paper 75 to 90 g/m2

(20 to 24 lb bond)
1 sheet
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Set minimum margins
The document margins must match (or exceed) these margin settings in portrait orientation.

Media (1) Left
margin

(2) Right
margin

(3) Top
margin

(4) Bottom
margin

A4
U.S. Executive
U.S. Statement
B5
A5

3.3 mm (0.13
inches)

3.3 mm (0.13
inches)

3 mm (0.12
inches)

3 mm (0.12
inches) *

U.S. Letter
U.S. Legal
Custom-size media
8.5 x 13 inches

6.35 mm
(0.25 inches)

6.35 mm
(0.25 inches)

3 mm (0.12
inches)

3 mm (0.12
inches) *

Cards
Photo media
A6

2 mm (0.08
inches)

2 mm (0.08
inches)

3 mm (0.12
inches)

3 mm (0.12
inches)

Envelopes 3.3 mm (0.13
inches)

3.3 mm (0.13
inches)

14.2 mm
(0.56 inches)

14.2 mm
(0.56 inches)

* If you are using a computer running Windows, you can enable the printer to use a minimum
margin of 3.0 mm (0.12 inches). To achieve this margin, click the Advanced tab in the print driver,
and select Minimize Margins.

Guidelines for two-sided (duplex) printing
• Always use media that conforms to the printer specifications. For more information, see

Media specifications.
• Specify duplex options in the application or in the print driver.
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• Do not print on both sides of envelopes, photo paper, glossy media, or paper lighter than 18
lb bond (75 g/m2). Jams might occur with these media types.

• Several kinds of media require a specific orientation when you print on both sides of a page,
such as letterhead, preprinted paper, and paper with watermarks and prepunched holes.
When you print from a computer running Windows, the printer prints the first side of the
media first. When you print from a computer using the Mac OS X, the printer prints the
second side first. Load the media with the front side facing down.

Print resolution

Black print resolution
Up to 600 dpi rendered black (when printing from a computer)

Color print resolution
Up to 4800 x 1200 optimized dpi color on select HP photo papers with 1200 input dpi. Photo
papers include the following:
◦ HP Premium Plus Photo
◦ HP Premium Photo
◦ HP Advanced Photo

Copy specifications
• Digital image processing
• Up to 99 copies from original
• Digital zoom: from 25 to 400%
• Copy speeds vary according to the complexity of the document
Refer to the following table to determine which paper type setting to select based on the paper
loaded in the main tray.

Paper type Printer control panel setting

Plain paper Plain Paper

HP Bright White Paper Plain Paper

HP Premium Presentation Paper, Matte Presentation Paper

Scan specifications
• Integrated OCR software automatically converts scanned text to editable text
• Scan speeds vary according to the complexity of the document
• Twain-compliant interface
• Resolution: 600 ppi optical, up to 4800 ppi enhanced
• Color: 24-bit total
• Maximum scan size: 216 x 356 mm (8.5 x 14 inches)
• Minimum scan size: 182 x 127 mm (7.17 x 5 inches)

Operating environment

Operating environment
Recommended relative humidity: 15 to 90% noncondensing
Recommended operating temperature: 15° to 32° C (59° to 90° F)
Maximum operating temperature: 5° to 40° C (41° to 104° F)
Battery charging and usage temperature: 0° to 40° C (32° to 104° F)
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Storage environment
Storage relative humidity: Up to 90% noncondensing at a temperature of 65° C (150° F)
Storage temperature: -40° to 60° C (-40° to 140° F)
Battery storage temperature: -20° to 60° C (-4° to 140° F)

Electrical requirements

Power supply
Universal power adapter (external)

Power requirements
Input voltage: 100 to 240 VAC (± 10%), 50/60 Hz (± 3Hz)
Output voltage: 18.5 Vdc at 3.5 A

Power consumption
28.4 watts printing (Fast Draft Mode); 32.5 watts copying (Normal Mode)

Acoustic emission specification
Print in Draft mode, noise levels per ISO 7779

Sound pressure (bystander position)
LpAd 56 (dBA)

Sound power
LwAd 7.0 (BA)
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Regulatory information
The printer meets product requirements from regulatory agencies in your country/region.
This section contains the following topics:
• Regulatory model number
• FCC statement
• Notice to users in Korea
• VCCI (Class B) compliance statement for users in Japan
• Notice to users in Japan about the power cord
• Noise emission statement for Germany
• LED indicator statement
• Gloss of housing of peripheral devices for Germany
• European Union Regulatory Notice
• Regulatory information for wireless products

Regulatory model number
For regulatory identification purposes, your product is assigned a Regulatory Model Number. The
Regulatory Model Number for your product is SNPRC-1003-02. This regulatory number should
not be confused with the marketing name (HP Officejet 150 (L511) Mobile All-in-One Printer) or
product number.
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FCC statement

FCC statement

The United States Federal Communications Commission (in 47 CFR 15.105) has specified 
that the following notice be brought to the attention of users of this product. 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reason-
able protection against harmful interference in a residential installation.  This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications.  
However, there is no guarantee that interference will not occur in a particular installation.  
If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct 
the interference by one or more of the following measures:
• Reorient the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.
For further information, contact:

Manager of Corporate Product Regulations
Hewlett-Packard Company
3000 Hanover Street
Palo Alto, Ca 94304
(650) 857-1501

Modifications (part 15.21)
The FCC requires the user to be notified that any changes or modifications made to this 
device that are not expressly approved by HP may void the user's authority to operate the 
equipment.
This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions:  (1) this device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.

Notice to users in Korea

VCCI (Class B) compliance statement for users in Japan

B

VCCI-B

Regulatory information 105



Notice to users in Japan about the power cord

Noise emission statement for Germany

Geräuschemission

LpA < 70 dB am Arbeitsplatz im Normalbetrieb nach DIN 45635 T. 19

LED indicator statement

Gloss of housing of peripheral devices for Germany

European Union Regulatory Notice
Products bearing the CE marking comply with the following EU Directives:
• Low Voltage Directive 2006/95/EC
• EMC Directive 2004/108/EC
• Ecodesign Directive 2009/125/EC, where applicable
CE compliance of this product is valid only if powered with the correct CE-marked AC adapter
provided by HP.
If this product has telecommunications functionality, it also complies with the essential
requirements of the following EU Directive:
R&TTE Directive 1999/5/EC
Compliance with these directives implies conformity to applicable harmonized European
standards (European Norms) that are listed in the EU Declaration of Conformity issued by HP for
this product or product family and available (in English only) either within the product
documentation or at the following web site: www.hp.com/go/certificates (type the product number
in the search field).
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The compliance is indicated by one of the following conformity markings placed on the product:

For non-telecommunications
products and for EU harmonized
telecommunications products, such
as Bluetooth® within power class
below 10mW.

For EU non-harmonized
telecommunications products (If
applicable, a 4-digit notified body
number is inserted between CE
and !).

Please refer to the regulatory label provided on the product.
The telecommunications functionality of this product may be used in the following EU and EFTA
countries: Austria, Belgium, Bulgaria, Cyprus, Czech Republic, Denmark, Estonia, Finland,
France, Germany, Greece, Hungary, Iceland, Ireland, Italy, Latvia, Liechtenstein, Lithuania,
Luxembourg, Malta, Netherlands, Norway, Poland, Portugal, Romania, Slovak Republic, Slovenia,
Spain, Sweden, Switzerland, and United Kingdom.
The telephone connector (not available for all products) is intended for connection to analogue
telephone networks.

Products with wireless LAN devices
Some countries may have specific obligations or special requirements about the operation of
Wireless LAN networks such as indoor use only or restrictions of the channels available. Please
make sure that the country settings of the wireless network are correct.

France
For 2.4-GHz Wireless LAN operation of this product, certain restrictions apply: This product may
be used indoors for the entire 2400-MHz to 2483.5-MHz frequency band (channels 1 to 13). For
outdoor use, only the 2400-MHz to 2454-MHz frequency band (channels 1 to 7) may be used. For
the latest requirements, see www.arcep.fr.
The point of contact for regulatory matters is:
Hewlett-Packard GmbH, Dept./MS: HQ-TRE, Herrenberger Strasse 140, 71034 Boeblingen,
GERMANY

Regulatory information for wireless products
This section contains the following regulatory information pertaining to wireless products:
• Exposure to radio frequency radiation
• Notice to users in Brazil
• Notice to users in Canada
• Notice to users in Taiwan
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Exposure to radio frequency radiation

Exposure to radio frequency radiation 

Caution The radiated output power of this device is far below the FCC radio 
frequency exposure limits. Nevertheless, the device shall be used in such a manner 
that the potential for human contact during normal operation is minimized. This 
product and any attached external antenna, if supported, shall be placed in such 
a manner to minimize the potential for human contact during normal operation. In 
order to avoid the possibility of exceeding the FCC radio frequency exposure 
limits, human proximity to the antenna shall not be less than 20 cm (8 inches) 
during normal operation. 

Notice to users in Brazil

Aviso aos usuários no Brasil

Este equipamento opera em caráter secundário, isto é, não tem direito à proteção contra 
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência 
a sistemas operando em caráter primário. (Res.ANATEL 282/2001).

Notice to users in Canada

Notice to users in Canada/Note à l'attention des utilisateurs canadiens

For Indoor Use. This digital apparatus does not exceed the Class B limits for radio noise 
emissions from the digital apparatus set out in the Radio Interference Regulations of the 
Canadian Department of Communications. The internal wireless radio complies with RSS 
210 and RSS GEN of Industry Canada.
Utiliser à l'intérieur. Le présent appareil numérique n'émet pas de bruit radioélectrique 
dépassant les limites applicables aux appareils numériques de la classe B prescrites dans 
le Règlement sur le brouillage radioélectrique édicté par le ministère des Communications 
du Canada. Le composant RF interne est conforme a la norme RSS-210 and RSS GEN 
d'Industrie Canada.
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Notice to users in Taiwan
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Environmental product stewardship program
Hewlett-Packard is committed to providing quality products in an environmentally sustainable
manner:
• Design for recycling has been incorporated into this product.
• The number of materials has been kept to a minimum while ensuring proper functionality

and reliability.
• Dissimilar materials have been designed to separate easily.
• Fasteners and other connections are easy to locate, access, and remove using common

tools.
• High priority parts have been designed to access quickly for efficient disassembly and

repair.
For more information, visit www.hp.com/ecosolutions.
This section contains the following topics:
• Paper use
• Plastics
• Material safety data sheets
• Recycling program
• HP inkjet supplies recycling program
• Disposal of waste equipment by users in private households in the European Union
• Power consumption
• Chemical Substances
• Battery information
• RoHS notices (China only)
• RoHS notices (Ukraine only)

Paper use
This product is suited for the use of recycled paper according to DIN 19309 and EN 12281:2002.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the
ability to identify plastics for recycling purposes at the end of product life.

Material safety data sheets
Material safety data sheets (MSDS) can be obtained from the HP Web site at:
www.hp.com/go/msds

Recycling program
HP offers an increasing number of product return and recycling programs in many countries/
regions, and partners with some of the largest electronic recycling centers throughout the world.
HP conserves resources by reselling some of its most popular products. For more information
regarding recycling of HP products, please visit:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/

HP inkjet supplies recycling program
HP is committed to protecting the environment. The HP Inkjet Supplies Recycling Program is
available in many countries/regions, and lets you recycle used print cartridges and ink cartridges
free of charge. For more information, go to the following Web site:
www.hp.com/hpinfo/globalcitizenship/environment/recycle/
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Disposal of waste equipment by users in private households in the European Union

Disposal of Waste Equipment by Users in Private Households in the European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with your other household waste. Instead, it is your responsibility to dispose of your waste 
equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment 
at the time of disposal will help to conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where 
you can drop off your waste equipment for recycling, please contact your local city office, your household waste disposal service or the shop where you purchased the product.
Évacuation des équipements usagés par les utilisateurs dans les foyers privés au sein de l'Union européenne
La présence de ce symbole sur le produit ou sur son emballage indique que vous ne pouvez pas vous débarrasser de ce produit de la même façon que vos déchets courants. 
Au contraire, vous êtes responsable de l'évacuation de vos équipements usagés et, à cet effet, vous êtes tenu de les remettre à un point de collecte agréé pour le recyclage des 
équipements électriques et électroniques usagés. Le tri, l'évacuation et le recyclage séparés de vos équipements usagés permettent de préserver les ressources naturelles et de s'assurer 
que ces équipements sont recyclés dans le respect de la santé humaine et de l'environnement. Pour plus d'informations sur les lieux de collecte des équipements usagés, veuillez contacter 
votre mairie, votre service de traitement des déchets ménagers ou le magasin où vous avez acheté le produit.
Entsorgung von Elektrogeräten durch Benutzer in privaten Haushalten in der EU
Dieses Symbol auf dem Produkt oder dessen Verpackung gibt an, dass das Produkt nicht zusammen mit dem Restmüll entsorgt werden darf. Es obliegt daher Ihrer Verantwortung, das 
Gerät an einer entsprechenden Stelle für die Entsorgung oder Wiederverwertung von Elektrogeräten aller Art abzugeben (z.B. ein Wertstoffhof). Die separate Sammlung und das 
Recyceln Ihrer alten Elektrogeräte zum Zeitpunkt ihrer Entsorgung trägt zum Schutz der Umwelt bei und gewährleistet, dass sie auf eine Art und Weise recycelt werden, die keine 
Gefährdung für die Gesundheit des Menschen und der Umwelt darstellt. Weitere Informationen darüber, wo Sie alte Elektrogeräte zum Recyceln abgeben können, erhalten Sie bei 
den örtlichen Behörden, Wertstoffhöfen oder dort, wo Sie das Gerät erworben haben.
Smaltimento di apparecchiature da rottamare da parte di privati nell'Unione Europea 
Questo simbolo che appare sul prodotto o sulla confezione indica che il prodotto non deve essere smaltito assieme agli altri rifiuti domestici. Gli utenti devono provvedere allo 
smaltimento delle apparecchiature da rottamare portandole al luogo di raccolta indicato per il riciclaggio delle apparecchiature elettriche ed elettroniche. La raccolta e il riciclaggio 
separati delle apparecchiature da rottamare in fase di smaltimento favoriscono la conservazione delle risorse naturali e garantiscono che tali apparecchiature vengano rottamate 
nel rispetto dell'ambiente e della tutela della salute. Per ulteriori informazioni sui punti di raccolta delle apparecchiature da rottamare, contattare il proprio comune di residenza, 
il servizio di smaltimento dei rifiuti locale o il negozio presso il quale è stato acquistato il prodotto.
Eliminación de residuos de aparatos eléctricos y electrónicos por parte de usuarios domésticos en la Unión Europea
Este símbolo en el producto o en el embalaje indica que no se puede desechar el producto junto con los residuos domésticos. Por el contrario, si debe eliminar este tipo de residuo, es 
responsabilidad del usuario entregarlo en un punto de recogida designado de reciclado de aparatos electrónicos y eléctricos. El reciclaje y la recogida por separado de estos residuos 
en el momento de la eliminación ayudará a preservar recursos naturales y a garantizar que el reciclaje proteja la salud y el medio ambiente. Si desea información adicional sobre los 
lugares donde puede dejar estos residuos para su reciclado, póngase en contacto con las autoridades locales de su ciudad, con el servicio de gestión de residuos domésticos o con la 
tienda donde adquirió el producto.
Likvidace vysloužilého zařízení uživateli v domácnosti v zemích EU
Tato značka na produktu nebo na jeho obalu označuje, že tento produkt nesmí být likvidován prostým vyhozením do běžného domovního odpadu. Odpovídáte za to, že vysloužilé 
zařízení bude předáno k likvidaci do stanovených sběrných míst určených k recyklaci vysloužilých elektrických a elektronických zařízení. Likvidace vysloužilého zařízení samostatným 
sběrem a recyklací napomáhá zachování přírodních zdrojů a zajišťuje, že recyklace proběhne způsobem chránícím lidské zdraví a životní prostředí. Další informace o tom, kam můžete 
vysloužilé zařízení předat k recyklaci, můžete získat od úřadů místní samosprávy, od společnosti provádějící svoz a likvidaci domovního odpadu nebo v obchodě, kde jste produkt 
zakoupili.
Bortskaffelse af affaldsudstyr for brugere i private husholdninger i EU
Dette symbol på produktet eller på dets emballage indikerer, at produktet ikke må bortskaffes sammen med andet husholdningsaffald. I stedet er det dit ansvar at bortskaffe affaldsudstyr 
ved at aflevere det på dertil beregnede indsamlingssteder med henblik på genbrug af elektrisk og elektronisk affaldsudstyr. Den separate indsamling og genbrug af dit affaldsudstyr på 
tidspunktet for bortskaffelse er med til at bevare naturlige ressourcer og sikre, at genbrug finder sted på en måde, der beskytter menneskers helbred samt miljøet. Hvis du vil vide mere 
om, hvor du kan aflevere dit affaldsudstyr til genbrug, kan du kontakte kommunen, det lokale renovationsvæsen eller den forretning, hvor du købte produktet.
Afvoer van afgedankte apparatuur door gebruikers in particuliere huishoudens in de Europese Unie
Dit symbool op het product of de verpakking geeft aan dat dit product niet mag worden afgevoerd met het huishoudelijk afval. Het is uw verantwoordelijkheid uw afgedankte apparatuur 
af te leveren op een aangewezen inzamelpunt voor de verwerking van afgedankte elektrische en elektronische apparatuur. De gescheiden inzameling en verwerking van uw afgedankte 
apparatuur draagt bij tot het sparen van natuurlijke bronnen en tot het hergebruik van materiaal op een wijze die de volksgezondheid en het milieu beschermt. Voor meer informatie over 
waar u uw afgedankte apparatuur kunt inleveren voor recycling kunt u contact opnemen met het gemeentehuis in uw woonplaats, de reinigingsdienst of de winkel waar u het product 
hebt aangeschaft.
Eramajapidamistes kasutuselt kõrvaldatavate seadmete käitlemine Euroopa Liidus
Kui tootel või toote pakendil on see sümbol, ei tohi seda toodet visata olmejäätmete hulka. Teie kohus on viia tarbetuks muutunud seade selleks ettenähtud elektri- ja elektroonikaseadmete 
utiliseerimiskohta. Utiliseeritavate seadmete eraldi kogumine ja käitlemine aitab säästa loodusvarasid ning tagada, et käitlemine toimub inimeste tervisele ja keskkonnale ohutult. 
Lisateavet selle kohta, kuhu saate utiliseeritava seadme käitlemiseks viia, saate küsida kohalikust omavalitsusest, olmejäätmete utiliseerimispunktist või kauplusest, kust te seadme 
ostsite.
Hävitettävien laitteiden käsittely kotitalouksissa Euroopan unionin alueella
Tämä tuotteessa tai sen pakkauksessa oleva merkintä osoittaa, että tuotetta ei saa hävittää talousjätteiden mukana. Käyttäjän velvollisuus on huolehtia siitä, että hävitettävä laite 
toimitetaan sähkö- ja elektroniikkalaiteromun keräyspisteeseen. Hävitettävien laitteiden erillinen keräys ja kierrätys säästää luonnonvaroja. Näin toimimalla varmistetaan myös, 
että kierrätys tapahtuu tavalla, joka suojelee ihmisten terveyttä ja ympäristöä. Saat tarvittaessa lisätietoja jätteiden kierrätyspaikoista paikallisilta viranomaisilta, jäteyhtiöiltä tai tuotteen 
jälleenmyyjältä.
Απόρριψη άχρηστων συσκευών στην Ευρωπαϊκή Ένωση
Το παρόν σύμβολο στον εξοπλισμό ή στη συσκευασία του υποδεικνύει ότι το προϊόν αυτό δεν πρέπει να πεταχτεί μαζί με άλλα οικιακά απορρίμματα. Αντίθετα, ευθύνη σας είναι να 
απορρίψετε τις άχρηστες συσκευές σε μια καθορισμένη μονάδα συλλογής απορριμμάτων για την ανακύκλωση άχρηστου ηλεκτρικού και ηλεκτρονικού εξοπλισμού. Η χωριστή συλλογή και 
ανακύκλωση των άχρηστων συσκευών θα συμβάλει στη διατήρηση των φυσικών πόρων και στη διασφάλιση ότι θα ανακυκλωθούν με τέτοιον τρόπο, ώστε να προστατεύεται η υγεία των 
ανθρώπων και το περιβάλλον. Για περισσότερες πληροφορίες σχετικά με το πού μπορείτε να απορρίψετε τις άχρηστες συσκευές για ανακύκλωση, επικοινωνήστε με τις κατά τόπους αρμόδιες 
αρχές ή με το κατάστημα από το οποίο αγοράσατε το προϊόν.
A hulladékanyagok kezelése a magánháztartásokban az Európai Unióban
Ez a szimbólum, amely a terméken vagy annak csomagolásán van feltüntetve, azt jelzi, hogy a termék nem kezelhető együtt az egyéb háztartási hulladékkal. Az Ön feladata, 
hogy a készülék hulladékanyagait eljuttassa olyan kijelölt gyűjtőhelyre, amely az elektromos hulladékanyagok és az elektronikus berendezések újrahasznosításával foglalkozik. 
A hulladékanyagok elkülönített gyűjtése és újrahasznosítása hozzájárul a természeti erőforrások megőrzéséhez, egyúttal azt is biztosítja, hogy a hulladék újrahasznosítása az 
egészségre és a környezetre nem ártalmas módon történik. Ha tájékoztatást szeretne kapni azokról a helyekről, ahol leadhatja újrahasznosításra a hulladékanyagokat, forduljon 
a helyi önkormányzathoz, a háztartási hulladék begyűjtésével foglalkozó vállalathoz vagy a termék forgalmazójához.
Lietotāju atbrīvošanās no nederīgām ierīcēm Eiropas Savienības privātajās mājsaimniecībās
Šis simbols uz ierīces vai tās iepakojuma norāda, ka šo ierīci nedrīkst izmest kopā ar pārējiem mājsaimniecības atkritumiem. Jūs esat atbildīgs par atbrīvošanos no nederīgās ierīces, 
to nododot norādītajā savākšanas vietā, lai tiktu veikta nederīgā elektriskā un elektroniskā aprīkojuma otrreizējā pārstrāde. Speciāla nederīgās ierīces savākšana un otrreizējā pārstrāde 
palīdz taupīt dabas resursus un nodrošina tādu otrreizējo pārstrādi, kas sargā cilvēku veselību un apkārtējo vidi. Lai iegūtu papildu informāciju par to, kur otrreizējai pārstrādei var 
nogādāt nederīgo ierīci, lūdzu, sazinieties ar vietējo pašvaldību, mājsaimniecības atkritumu savākšanas dienestu vai veikalu, kurā iegādājāties šo ierīci.
Europos Sąjungos vartotojų ir privačių namų ūkių atliekamos įrangos išmetimas
Šis simbolis ant produkto arba jo pakuotės nurodo, kad produktas negali būti išmestas kartu su kitomis namų ūkio atliekomis. Jūs privalote išmesti savo atliekamą įrangą atiduodami ją 
į atliekamos elektronikos ir elektros įrangos perdirbimo punktus. Jei atliekama įranga bus atskirai surenkama ir perdirbama, bus išsaugomi natūralūs ištekliai ir užtikrinama, kad įranga 
yra perdirbta žmogaus sveikatą ir gamtą tausojančiu būdu. Dėl informacijos apie tai, kur galite išmesti atliekamą perdirbti skirtą įrangą kreipkitės į atitinkamą vietos tarnybą, namų ūkio 
atliekų išvežimo tarnybą arba į parduotuvę, kurioje pirkote produktą.
Utylizacja zużytego sprzętu przez użytkowników domowych w Unii Europejskiej
Symbol ten umieszczony na produkcie lub opakowaniu oznacza, że tego produktu nie należy wyrzucać razem z innymi odpadami domowymi. Użytkownik jest odpowiedzialny za 
dostarczenie zużytego sprzętu do wyznaczonego punktu gromadzenia zużytych urządzeń elektrycznych i elektronicznych. Gromadzenie osobno i recykling tego typu odpadów 
przyczynia się do ochrony zasobów naturalnych i jest bezpieczny dla zdrowia i środowiska naturalnego. Dalsze informacje na temat sposobu utylizacji zużytych urządzeń można 
uzyskać u odpowiednich władz lokalnych, w przedsiębiorstwie zajmującym się usuwaniem odpadów lub w miejscu zakupu produktu.
Descarte de equipamentos por usuários em residências da União Européia
Este símbolo no produto ou na embalagem indica que o produto não pode ser descartado junto com o lixo doméstico. No entanto, é sua responsabilidade levar os equipamentos 
a serem descartados a um ponto de coleta designado para a reciclagem de equipamentos eletro-eletrônicos. A coleta separada e a reciclagem dos equipamentos no momento do 
descarte ajudam na conservação dos recursos naturais e garantem que os equipamentos serão reciclados de forma a proteger a saúde das pessoas e o meio ambiente. Para obter mais 
informações sobre onde descartar equipamentos para reciclagem, entre em contato com o escritório local de sua cidade, o serviço de limpeza pública de seu bairro ou a loja em que 
adquiriu o produto.
Postup používateľov v krajinách Európskej únie pri vyhadzovaní zariadenia v domácom používaní do odpadu
Tento symbol na produkte alebo na jeho obale znamená, že nesmie by vyhodený s iným komunálnym odpadom. Namiesto toho máte povinnos odovzda toto zariadenie na zbernom 
mieste, kde sa zabezpečuje recyklácia elektrických a elektronických zariadení. Separovaný zber a recyklácia zariadenia určeného na odpad pomôže chráni prírodné zdroje a 
zabezpečí taký spôsob recyklácie, ktorý bude chráni ľudské zdravie a životné prostredie. Ďalšie informácie o separovanom zbere a recyklácii získate na miestnom obecnom úrade, 
vo firme zabezpečujúcej zber vášho komunálneho odpadu alebo v predajni, kde ste produkt kúpili.
Ravnanje z odpadno opremo v gospodinjstvih znotraj Evropske unije
Ta znak na izdelku ali embalaži izdelka pomeni, da izdelka ne smete odlagati skupaj z drugimi gospodinjskimi odpadki. Odpadno opremo ste dolžni oddati na določenem zbirnem 
mestu za recikliranje odpadne električne in elektronske opreme. Z ločenim zbiranjem in recikliranjem odpadne opreme ob odlaganju boste pomagali ohraniti naravne vire in zagotovili, 
da bo odpadna oprema reciklirana tako, da se varuje zdravje ljudi in okolje. Več informacij o mestih, kjer lahko oddate odpadno opremo za recikliranje, lahko dobite na občini, 
v komunalnem podjetju ali trgovini, kjer ste izdelek kupili.
Kassering av förbrukningsmaterial, för hem- och privatanvändare i EU
Produkter eller produktförpackningar med den här symbolen får inte kasseras med vanligt hushållsavfall. I stället har du ansvar för att produkten lämnas till en behörig återvinningsstation 
för hantering av el- och elektronikprodukter. Genom att lämna kasserade produkter till återvinning hjälper du till att bevara våra gemensamma naturresurser. Dessutom skyddas både 
människor och miljön när produkter återvinns på rätt sätt. Kommunala myndigheter, sophanteringsföretag eller butiken där varan köptes kan ge mer information om var du lämnar 
kasserade produkter för återvinning.
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Power consumption
Hewlett-Packard printing and imaging equipment marked with the ENERGY STAR® logo is
qualified to the U.S. Environmental Protection Agency’s ENERGY STAR specifications for
imaging equipment. The following mark appears on ENERGY STAR qualified imaging products:

ENERGY STAR is a U.S. registered service mark of the U.S. EPA. As an ENERGY STAR
partner, HP has determined that this product meets ENERGY STAR guidelines for energy
efficiency.
Additional ENERGY STAR qualified imaging product model information is listed at:
www.hp.com/go/energystar

Chemical Substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No
1907/2006 of the European Parliament and the Council). A chemical information report for this
product can be found at: www.hp.com/go/reach

Battery information
The printer comes with a lithium-ion rechargeable battery. This battery might require special
handling and disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to www.hp.com/
recycle.

Attention California users
The battery supplied with this product may contain perchlorate material. Special handling may
apply. For more information, go to the following web site: www.dtsc.ca.gov/hazardouswaste/
perchlorate.
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RoHS notices (China only)

Toxic and hazardous substance table

RoHS notices (Ukraine only)
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Third-party licenses
This section contains the following topics:
• HP Officejet 150 (L511) Mobile Printer

HP Officejet 150 (L511) Mobile Printer
Third-party licences

 Zlib
---------
Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or
implied warranty. In no event will the authors be held liable
for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any
purpose, including commercial applications, and to alter it and
redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you
must not claim that you wrote the original software. If you use
this software in a product, an acknowledgment in the product
documentation would be appreciated but is not required.
2. Altered source versions must be plainly marked as such, and
must not be misrepresented as being the original software
3. This notice may not be removed or altered from any source
distribution.

Jean-loup Gailly Mark Adler
jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs
(Request for Comments) 1950 to 1952 in the files ftp://
ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt
(deflate format) and rfc1952.txt (gzip format).

 Independent JPEG Group's free JPEG software
 -------------------------------------------

 * Copyright (C) 1991-1998, Thomas G. Lane.
* This file is part of the Independent JPEG Group's software.
* For conditions of distribution and use, see the accompanying
README file.
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Readme File

Independent JPEG Group's free JPEG software
-------------------------------------------

This package contains C software to implement JPEG image encoding, decoding, and
transcoding. JPEG is a standardized compression method for full-color and gray-scale images.

The distributed programs provide conversion between JPEG "JFIF" format and image files in
PBMPLUS PPM/PGM, GIF, BMP, and Targa file formats. The core compression and
decompression library can easily be reused in other programs, such as image viewers. The
package is highly portable C code; we have tested it on many machines ranging from PCs to
Crays.

We are releasing this software for both noncommercial and commercial use. Companies are
welcome to use it as the basis for JPEG-related products.

We do not ask a royalty, although we do ask for an acknowledgement in
product literature (see the README file in the distribution for details). We hope to make this
software industrial-quality --- although, as with anything that's free, we offer no warranty and
accept no liability.

For more information, contact jpeg-info@uc.ag

LIBTIFF
----------

Copyright (c) 1991-1996 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this
software and its documentation for any purpose is hereby
granted without fee, provided that (i) the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler
and Silicon Graphics may not be used in any advertising or publicity relating to the software
without the specific, prior written permission of Sam Leffler
and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY
KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT
LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR
ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF
ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE,
DATA OR PROFITS,WHETHER OR NOT ADVISED OF THE POSSIBILITY OF
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DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

TIFF Library.
Rev 5.0 Lempel-Ziv & Welch Compression Support

This code is derived from the compress program whose code is
derived from software contributed to Berkeley by James A. Woods,
derived from original work by Spencer Thomas and Joseph Orost.

The original Berkeley copyright notice appears below in its
entirety.

Copyright (c) 1985, 1986 The Regents of the University of
California.All rights reserved.

This code is derived from software contributed to Berkeley by
James A. Woods, derived from original work by Spencer Thomas
and Joseph Orost.

Redistribution and use in source and binary forms are permitted
provided that the above copyright notice and this paragraph are
duplicated in all such forms and that any documentation,
advertising materials, and other materials related to such
distribution and use acknowledge that the software was developed
by the University of California, Berkeley. The name of the
University may not be used to endorse or promote products
derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED ``AS IS AND WITHOUT ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE IMPLIED

WARRANTIES OF MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE.
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B HP supplies and accessories
This section provides information on HP supplies and accessories for the printer. The information
is subject to changes, visit the HP Web site (www.hpshopping.com) for the latest updates. You
can also make purchases through the Web site.
This section contains the following topics:
• Order printing supplies online
• Accessories
• Supplies

Order printing supplies online
To order supplies online or create a printable shopping list, open the HP software that came with
the printer and then open Toolbox (Windows). Click the Estimated Ink Levels tab, and then click
Shop Online. With your permission, the HP software uploads printer information, including model
number, serial number, and estimated ink levels. The HP supplies that work in the printer are pre-
selected. You can change quantities, add or remove items, and then print the list or purchase
online at the HP Store or other online retailers (options differ by country/region). Cartridge
information and links to online shopping also appear on ink alert messages.
You can also order online by visiting www.hp.com/buy/supplies. If prompted, choose your country/
region, follow the prompts to select the printer, and then select the supplies you need.

NOTE: Ordering cartridges online is not supported in all countries/regions. However, many
countries/regions have information on ordering by telephone, locating a local store and
printing a shopping list. In addition, you can select the 'How to Buy' option at the top of the
www.hp.com/buy/supplies page to obtain information about purchasing HP products in your
country/region.

Accessories
The following accessories can be used with your HP Officejet mobile printer.

HP Battery for Officejet Mobile Printer CQ775A

HP Mobile Printer and Notebook Case Q6282A

Supplies
This section covers the following topics:
• Ink cartridges
• HP media

Ink cartridges
You can find the ink cartridge number in the following places:
• On the label of the ink cartridge you are replacing.
• On the printer status page (see Understand the printer information pages).
• In the Cartridge details feature in Toolbox. Different cartridge numbers are sold in each

country/region. To get the complete list of the cartridge numbers sold in each country/
region, use the Travelling Information feature in Toolbox. For more information, see Toolbox
(Windows).
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NOTE: Ink level warnings and indicators provide estimates for planning purposes only.
When you receive a low-ink warning message, consider having a replacement cartridge
available to avoid possible printing delays. You do not need to replace cartridges until
prompted to do so.

HP media
To order media such as HP Premium Paper, go to www.hp.com.

HP recommends plain papers with the ColorLok logo for printing
everyday documents. All papers with the ColorLok logo are
independently tested to meet high standards of reliability and
print quality, and produce documents with crisp, vivid color,
bolder blacks, and dry faster than ordinary plain papers. Look for
papers with the ColorLok logo in a variety of weights and sizes
from major paper manufacturers.
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C Set up the printer for Bluetooth
communication
The printer allows you to print documents from Bluetooth devices without a cable connection.
Simply print from a Bluetooth device such as a PDA or camera phone. You can also use
Bluetooth technology to print from a computer to the printer.

NOTE: The only software functionality available with a Bluetooth connection is printing.
Scanning cannot be done over a Bluetooth connection.

This section contains the following topics:
• Set up a Bluetooth connection
• Set Bluetooth security for the printer

Set up a Bluetooth connection
This section describes how to set up and configure the device for a Bluetooth wireless connection.
You can configure Bluetooth wireless settings during software installation, or you can configure
settings later using Toolbox (Windows), HP Utility (Mac OS X), or the Toolbox software for PDAs
(Windows Mobile). For more information, see Printer management tools.

To connect the printer using Bluetooth communication (Windows)

NOTE: If you are using an external Bluetooth adapter for your computer, specific instructions
for adding the printer might be different. For more information, see the documentation or utility
provided with the Bluetooth adapter.

1. If you are using an external Bluetooth adapter for your computer, make sure your computer
is started and then attach the Bluetooth adapter to a USB port on the computer.
If your computer has Bluetooth built in, just make sure the computer is started and that
Bluetooth is turned on.

2. On the Windows taskbar, click Start, click Control Panel, click Hardware and Sound, and
then click Add a printer.
- Or -
Click Start, click Printer or Printers and Faxes, and then double-click the Add Printer icon
or click Add a printer.

3. Follow the onscreen instructions to finish the installation.

To connect the printer using Bluetooth communication (Mac OS X)
1. If you are using an external Bluetooth adapter for your computer, make sure your computer

is started and then attach the Bluetooth adapter to a USB port on the computer.
If your computer has Bluetooth built in, just make sure the computer is started and that
Bluetooth is turned on.

2. Click System Preferences in the Dock, and then click Print & Fax or Print & Scan .
3. Click + (Add).
4. Select the entry for the printer in the list with Bluetooth beside its name, and then click

Add.
5. Follow the onscreen instructions to finish the installation.
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Set Bluetooth security for the printer
You can enable the following printer security settings from the printer’s control panel
• Require passkey authentication prior to someone printing to the printer from a Bluetooth

device.
• Make the printer visible or invisible to Bluetooth printers that are within range.

TIP: You can also use Toolbox (Windows), HP Utility (Mac OS X), or the Toolbox software
for PDAs (Windows Mobile) to configure these settings. For more information, see Printer
management tools.

This section contains the following topics:
• Set the Bluetooth Security Level
• Set the printer to be visible or not visible to Bluetooth devices
• Reset Bluetooth settings

Set the Bluetooth Security Level
You can set the security level of the printer to either High or Low.

NOTE: You can also change the Bluetooth settings using Toolbox (Windows). For more
information, see Toolbox (Windows).

• Low: The printer does not require a passkey. Any Bluetooth device within range can print to
it.

NOTE: The default security setting is Low. Low level security does not require
authentication.

• High: The printer requires a passkey from the Bluetooth device before allowing the printer
to send a print job to it.

NOTE: The printer ships with a predefined passkey that is set to six zeroes "000000".

To set the printer to require passkey authentication
1. Touch right arrow , and then select Bluetooth.
2. Select Settings, and then select Passkey.
3. Select Change, and then use the keypad to enter a new passkey.
4. When you have finished entering your passkey, touch Done.
5. Select Security Level, and then select High.
6. High level security requires authentication.

Passkey authentication is now set for the printer.

Set the printer to be visible or not visible to Bluetooth devices
You can set the printer to be either visible to Bluetooth devices (public) or not visible to any
(private).
• Visible: Any Bluetooth device within range can print to the printer.
• Not visible: Only Bluetooth devices that have stored the device address of the printer can

print to it.

NOTE: The printer ships with a default accessibility level of Visible.
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To set the printer to be not visible
1. Touch right arrow , and then touch Bluetooth on the control panel.
2. Select Settings, and then select Visibility.
3. Touch Not Visible.

The printer is inaccessible to Bluetooth devices that have not stored its device address.

Reset Bluetooth settings
To reset Bluetooth settings on the printer to the factory defaults:
1. Touch right arrow , and then touch Bluetooth on the control panel.
2. Touch Settings, and then touch Reset Bluetooth.
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D Printer management tools
This section contains the following topics:
• Toolbox (Windows)
• HP Utility (Mac OS X)
• Toolbox software for PDAs (Microsoft Windows Mobile)
• Uninstall and reinstall the HP software

Toolbox (Windows)
Toolbox provides maintenance information about the printer.

NOTE: Toolbox can be installed from the HP software CD by selecting the full installation
option if the computer meets the system requirements.

Open Toolbox
You can open Toolbox using one of the following methods:
• Click Start, select Programs or All Programs, click HP, click the folder for your printer, and

then click Toolbox.
• Right-click the HP Digital Imaging Monitor in the taskbar, point to Printer Model Name, and

then click Display Printer Toolbox.
• From the printer preferences, click the Features tab, and then click Printer Services.

HP Utility (Mac OS X)
HP Utility contains tools to configure print settings, calibrate the printer, order supplies online, and
find website support information.

NOTE: The features available in HP Utility vary depending on the selected printer.
Ink level warnings and indicators provide estimates for planning purposes only. When you
receive a low on ink message, consider having a replacement cartridge available to avoid
possible printing delays. You do not need to replace cartridges until prompted to do so.

Open HP Utility
To open HP Utility, double-click the HP Utility icon. This icon is located in the Hewlett-Packard
folder in the Applications folder at the top level of the hard disk.

Toolbox software for PDAs (Microsoft Windows Mobile)
The Toolbox software for PDAs running Windows Mobile allows you to view status and
maintenance information about the printer. You can view ink levels and battery charge level, align
the print cartridges, and configure Bluetooth settings for wireless printing.
See the Toolbox software documentation for more information on using Toolbox, or visit
www.hp.com/support.

Uninstall and reinstall the HP software
If the installation is incomplete, or if you connected the USB cable to the computer before
prompted by the HP software installation screen, you might need to uninstall and then reinstall the
HP software that came with the printer. Do not simply delete the printer application files from the
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computer. Make sure to remove them correctly using the uninstall utility provided when you
installed the HP software.
There are three methods to uninstall the HP software on a Windows computer, and one method to
uninstall on a Macintosh computer.

To uninstall from a Windows computer, method 1
1. Disconnect the printer from your computer. Do not connect the printer to your computer until

you are prompted to do so by the HP software during the reinstall.
2. On the Windows taskbar, click Start, select Programs or All Programs, select HP, select

the printer name, and then click Uninstall.
3. Follow the onscreen instructions.
4. If you are asked whether you would like to remove shared files, click No.

Other programs that use these files might not work correctly if the files are deleted.
5. Restart the computer.
6. To reinstall the HP software, insert the HP software CD into the computer's CD drive, follow

the onscreen instructions.
7. Connect the printer when the HP software prompts you to connect it to the computer.
8. Press the  (Power) button to turn the printer on.

After connecting and turning on the printer, you might have to wait several minutes for all of
the Plug and Play events to complete.

9. Follow the onscreen instructions.

To uninstall from a Windows computer, method 2

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. Disconnect the printer from the computer.

NOTE: It is important that you disconnect the printer before restarting your computer.
Do not connect the printer to your computer until you are prompted to do so by the HP
software during the install.

2. On the Windows taskbar, click Start, select Settings, select Control Panel, and then click
Add/Remove Programs.
- Or -
Click Start, click Control Panel, and then double-click Programs and Features.

3. Select the printer name, and then click Change/Remove or Uninstall/Change.
Follow the onscreen instructions.

4. Restart the computer.
5. Insert the HP software CD into the computer's CD drive and then start the Setup program.
6. Follow the onscreen instructions.

To uninstall from a Windows computer, method 3

NOTE: Use this method if Uninstall is not available in the Windows Start menu.

1. Insert the HP software CD into the computer's CD drive, and then start the Setup program.
2. Disconnect the printer from your computer. Do not connect the printer to your computer until

you are prompted to do so by the HP software during the reinstall.
3. Select Uninstall and follow the onscreen directions.
4. Restart the computer.
5. Start the Setup program for the printer again.
6. Select Install.
7. Follow the onscreen instructions.
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To uninstall from a Macintosh computer, method 1
1. Open HP Utility. For instructions, see Open HP Utility.
2. Click the Application icon on the toolbar.
3. Double click HP Uninstaller.

Follow the onscreen instructions.
4. After the HP software is uninstalled, restart the computer.
5. To reinstall the HP software, insert the HP software CD into the computer's CD drive.
6. On the desktop, open the CD, and then double-click HP Installer.
7. Follow the onscreen instructions.

To uninstall from a Macintosh computer, method 2
1. Open the Finder.
2. Double-click Applications.
3. Double-click Hewlett-Packard.
4. Double-click HP Uninstaller.
5. Select the printer, and then double-click Uninstall.
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E How do I?
• Get started
• Print
• Scan
• Copy
• Work with ink cartridges
• Solve a problem
• Set up the printer for Bluetooth communication
• Order printing supplies online
• Contact HP Support

How do I? 127



Appendix E

128 How do I?



Index

A
accessibility 7
accessories

warranty 94
acoustic emissions 103
after the support period 63
aligning ink cartridges 55

B
battery

charging 25
installing 24
recycling 24
removing 26
safety 24

black and white pages
copy 49
troubleshoot 72

blank pages, troubleshoot
copy 80
print 66
scan 85

Bluetooth
security settings 120
setup 119
troubleshooting 87

both sides, print on 40
buttons, control panel 12

C
calibrate linefeed 56
cameras

insert memory devices 26
Cancel 12
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trays 100
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sizes supported 99
tray supporting 100

cartridges. See ink cartridges
clean

ink cartridge contacts 75
ink cartridge ink nozzle

area 76
cleaning

ink cartridges 56

color copy 49
colored text, and OCR 45
colors

bleeding 73
faded or dull 71
print black and white,

troubleshoot 72
troubleshoot 73
wrong 72

connections
Bluetooth 119

connectors, locating 11
control panel

buttons 12
lights 12
status icons 13

Copy 13
copy

quality 80
settings 49
specifications 102
troubleshoot 79

copy settings
copy 50

custom-size paper
Mac OS 37, 38
print on 37

custom-sized media
sizes supported 100

customer support
electronic 59

cut-off pages, troubleshoot 68

D
dark images, troubleshoot

copies 81
scans 85

default settings
copy 50

digital cameras
insert memory devices 26

double-sided printing 40
driver

warranty 94
duplexing 40

E
edit

text in OCR program 45
electrical specifications 103
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sizes supported 99
tray supporting 100

environmental
specifications 102

environmental sustainability
program 110

error messages
unable to activate TWAIN

source 84

F
faded copies 80
faded stripes on copies,

troubleshoot 81
firewalls, troubleshoot 65

G
glass, scanner

locating 9
graphics

incompletely filled on
copies 81

ink not filling in 71
look different from original

scan 85
streaks or lines 74

H
Help 13
Hewlett-Packard Company
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HP software

uninstall from Mac OS
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uninstall from Windows 124
HP Utility (Mac OS X)

opening 123
humidity specifications 102
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I
ink cartridge

troubleshoot 65
ink cartridge door, locating 10
ink cartridge latch, locating 10
ink cartridges

aligning 55
check ink levels 52
clean contacts 75
clean ink nozzle area 76
cleaning 56
handle 52
locating 10
ordering online 117
part names 52
part numbers 117
replace 53
supported 96
tips 51
warranty 94
yields 96

ink level icons 13
ink levels, check 52
ink smearing, troubleshoot 70
input tray

load media 18
installation

ink cartridges 53
troubleshoot 85

J
jams

clear 88
media to avoid 17
prevent 91

L
language, printer 96
light images, troubleshoot

copies 81
scans 85

lights, control panel 12
linefeed, calibrate 56
lines

scans, troubleshoot 85
load

photo 22, 23
tray 19, 21

load cards 22, 23
load envelopes 21
load media 19

M
Mac OS

custom-size paper 37, 38
Print borderless 39
Print photos 36
print settings 32

Mac OS X
HP Utility 123
uninstall HP software 125

maintenance
check ink levels 52

margins
setting, specifications 101

media
clear jams 88
duplexing 40
load input tray  18
print on custom-size 37
selecting 17
specifications 98
supported sizes 98
types and weights

supported 100
memory device

insert 26
memory devices

insert 26
print files 37

missing or incorrect information,
troubleshoot 67

multi-feeds, troubleshoot 79

N
network

printer information 87
networks

connector illustration 11
firewalls, troubleshoot 65

noise information 103

O
OCR

edit scanned documents 45
troubleshoot 83

operating environment
specifications 102

operating systems
supported 97

originals
scan 43

output outlet
locating 9

P
paper

ordering 118
paper-feed problems,

troubleshoot 78
part numbers, supplies and

accessories 117
passkey authentication,

Bluetooth 120
PCL 3 support 96
phone support 60
phone support period

period for support 60
photo media

sizes supported 99
Photo screen 13
photos

insert memory devices 26
print from memory

devices 37
PictBridge 67
ports, specifications 96
power

specifications 103
power input, locating 11
print

Bluetooth 119
double-sided 40
photos from memory

devices 37
slow 65
troubleshoot 64

Print borderless
Mac OS 39
Windows 39

Print brochures
print 33

print driver
warranty 94

Print envelope 33
Print envelopes

Mac OS 34
Print photos

Mac OS 36
Windows 36

print quality
troubleshoot 68

print-carriage access door,
locating 10

printer control panel
locating 9
scan from 43
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printer information pages
printing, understanding 87

printer software (Windows)
about 123

printheads
ordering online 117
part numbers 117

processor specifications 97

Q
quality, troubleshoot

copy 80
print 68
scan 84

R
radio interference

regulatory information 107
rear access panel

illustration 11
recycle

ink cartridges 110
regulatory information 104, 107
regulatory model number 104
replace

ink cartridges 53
right navigation 12, 13

S
scan

error messages 84
from printer control panel 43
OCR 45
quality 84
Scan screen 13
scan specifications 102
slow 83
troubleshoot 82

Scan screen 13
scanner

load originals 17
media sizes supported 98

scanner glass
locating 9

Secure Digital memory device
insert 26

security
Bluetooth 120

send scans
for OCR 45
troubleshoot 82

settings
copy 49

Setup 13
setup

Bluetooth 119
size

scans, troubleshoot 85
troubleshoot copy 80

skew, troubleshoot
copy 81
scan 84

skewed pages, troubleshoot 78
slow print, troubleshoot 65
software

OCR 45
warranty 94

sound pressure 103
specifications

acoustic emissions 103
electrical 103
media 98
operating environment 102
physical 96
processor and memory 97
storage environment 103
system requirements 97

speed
troubleshoot for scanner 83
troubleshoot print 65

status icons 13
storage environment

specifications 103
streaks or lines, troubleshoot 74
stripes on scans,

troubleshoot 85
supplies

ordering online 117
yields 96

support  59
system requirements 97

T
technical information

copy specifications 102
scan specifications 102

temperature specifications 102
text

cannot be edited after scan,
troubleshoot 83

incompletely filled on
copies 81

missing from scan,
troubleshoot 83

splotchy on copies 81
troubleshoot 68, 71, 74
unclear on copies,

troubleshoot 81
unclear scans 85

Toolbox (Windows)
about 123
opening 123

tray 1
capacity 100
media sizes supported 98
media types and weights
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